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The main objective of this practical guide is to serve as reference tool and set down the basic
departmental guidelines for writing an MA Thesis at the Department of Medieval Studies at
CEU. Besides the actual thesis writing process, this handy guide is hoped to guide you through
writing term papers, assignments and your prospectus.
As Academic Writing is a strong component in the MA Thesis Seminars from the beginning,
this handbook provides detailed information about assignments required in the Thesis
Seminars. These seminars are designed to guide you through the difficult process of planning,
focusing, structuring, revising, editing, rewriting (and then rewriting, more rewriting, and then
some) of your thesis and thus, these assignments will help you to create the backbone of your
thesis in the form of coursework. This is why more specific information about these
assignments is included in this thesis handbook. Although guidance is also provided for other
coursework in general, always make sure to check the specific requirements in the syllabus or
consult your professor.
You are now embarking on a journey whereby you will gradually develop and consciously
improve a habit of writing that will stay with you for the rest of your life. You will be attentive
to detail, concise and clear, informative and precise, reader-friendly and able to communicate
your arguments and your acumen in your chosen field convincingly, ethically and – it is hoped
– with scholarly flair.
The field of Medieval Studies, with its inter- and trans-disciplinary approaches, myriad of
methodologies, ancient and modern languages, various writing systems and formats makes
academic writing especially challenging. This guide, together with the MA Booklet, will be
your anchor throughout your studies at CEU, providing the bare bones, tiny but all-important
details and technicalities until it all becomes second nature.
Please note that this guide is constantly updated based on central CEU guidelines, which may
change, as well as valuable student feedback and comments from the professors and instructors.
If you save or print a copy, always make sure that you check for updates frequently as it is your
own responsibility to always use the latest edition. The date of last modification can be found
at the bottom of each page.

1. Formatting
This chapter contains basic computer set-up instructions, but please do not skip these pages
entirely even if you are familiar with them. Important notes, specific to writing a thesis at CEU,
will be marked with a

symbol, so make sure to have a look at them.
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Regardless of the word processor (Word or open source software) or the operating system
(Windows, Linux, IOS) you prefer to use, your final thesis submitted is required to follow the
university’s formatting guidelines precisely.
CEU provides a Thesis Template to make formatting easier. It is advisable to work in the
template or follow the guidelines from the beginning and produce all your written assignments
and thesis drafts using the template and guidelines provided. Following the same format for
research papers and theses also makes it easier to manage, merge and revise various items as
you go.
No matter how skilled you are in formatting and editing long documents, adopting this practice
will save you from headaches and free up precious writing up time as the submission deadline
begins to loom on the horizon.

1.1 Preparing Documents for Submission
It is advisable to follow the formatting guidelines for papers, prospectus and thesis for several
reasons. First, it is good practice to get used to the guidelines you will have to adopt in your
thesis from the beginning of your studies. Secondly, submitting your papers to you professors
in a professional and consistent style, which is easy to navigate and identify is recommended.
Thirdly, it is not uncommon that parts of your research papers submitted to various courses end
up in your thesis, in the event of which it is easier to merge uniformly formatted documents.

1.1.1Course Paper and Prospectus Formatting
It is recommended that course papers submitted to your instructors and professors are
formatted similarly to the thesis, with one marked difference: these documents usually have
no front matter and thus have to be identified differently.
The format required by your professor may be different from the generally
recommended guidelines below, please consult them well in advance prior to the
submission deadline. Similarly, always check the preferred mode of submission for
each specific assignment, whether e-learning, e-mail or hard copy.

Title, author, etc.
It is recommended that you submit your work in a Word document unless otherwise specified
by your professor.
Do not forget to have the title and your name at the top of the first page, regardless whether
you included them in the header or footer on the first page of the document.
2

Although papers submitted through the e-learning site are easily identifiable, in some instances
you will be required to hand in assignments on paper or by e-mail. In addition, your professor(s)
may need to print your work for marking. In order to make the paper/prospectus easily
identifiable at all stages, make sure you include all essential details in the header and footer
of the document so that the information is displayed on each page and loose printed sheets can
be identified in the marking process if necessary. Text in the header should be small (10pt font)
and may be gray in order to avoid cluttering your pages.

Sample front page of course assignment

To edit the header or footer of the document, double click the top or bottom of any page
respectively and type your text. Exit the header or footer by double clicking elsewhere on the
page.
The following details must appear in the header / footer of your papers and prospectus in your
preferred order and format:





Your name
Course title (for course papers) / Prospectus for [Programme Title] (for prospectuses)
Date of submission
Page numbers - recommended format: [page number] of [total number of pages]

To insert and edit page numbers:
3

On the Insert tab on the tool bar, in the Header & Footer group, click Page Number. Click
‘Top of Page’, or ‘Bottom of Page’, depending on where you want page numbers to appear in
your document. Scroll down in the drop-down gallery of designs to see the ‘Page X of Y’ styles
and pick the one you prefer.
Do not attempt to add page numbers manually.

Margins
Click the Page Layout tab on the tool bar:
Select Margins,
Set the Top, Bottom, Right and Left margins to 1” (inch)
If the measurement is in centimeters, you can set it to inches:
File tab > Options > Advanced tab > Display
Set the Gutter measurements to 0.

Language
Make sure to use English (preferably US) as the language setting, normally in the lower
left of the screen.
Please note that setting the language to English, besides being useful for the autocorrect option, is also essential for punctuation. For example, only the so-called
‘smart quotes’ (“curly” upper quotation marks and apostrophes) are acceptable as
quotation marks, which normally vary widely across other languages.
Your quotation marks may be auto-corrected to non-standard if your language is
set to a language other than English. You can avoid non-standard quotation marks
by setting the language to English either by setting it as default as above or
manually by highlighting the desired passage. This is especially important for
footnotes.

Font
Go to the Home tab on the tool bar.
In the Font section, click on the tiny arrow in the bottom right to open the dialogue
box or use buttons.
Set the Font to Times New Roman,
Set the Font Style to Regular (i.e. not bold, italics, or underlined),
Set the Size to 12.
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Spacing, Alignment and Indentation
Go to the Home tab on the tool bar.
In the Paragraph section, click on the tiny arrow in the bottom right to open the
dialogue box:
Set the Alignment to Justified,
Set the Indentation (Right and Left) to 0,
Set the Spacing:
‘0’ (Before and After) for ordinary text
‘12 After’ for bibliographies,
Set Outline Level to Body Text.
Set Line Spacing:
Double for ordinary text,
Single for bibliographies, table titles and captions.
Do not use tabs and spaces for indenting and block quotes.
For texts and bibliographies, use Special indentation.
First Line for ordinary text,
Hanging for bibliographies.
If you have a quotation in your text that is more than three lines long, the
quote should be given as a block quote: single-spaced, and indented 0.5
inches on the left and right. The spacing is still 0.
Highlight the text you want to alter and then change these settings; they
should change back automatically when you return to the regular text.

1.1.2 Thesis Formatting
If you are using a shared computer or a computer in one of the labs you will need to check the
settings to make sure they are correct for your work.

CEU Template
The Thesis Template is available at the CEU Computer and Statistics Centre’s e-learning
site:
CEU Home ► Courses ► Computer and Statistics Center ► Thesis Submission
This is pre-programmed and contains all the text and header styles necessary for your work,
including the mandatory front matter, table of contents and appendices, so you can save it on
your computer and type your text directly in it.
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The Medieval Studies and Comparative History thesis templates are slightly different. When
compiling the final version of your thesis please make sure you use the correct template.
Some formatting advice can be found below based on Microsoft Word settings, but please note
that these can (and should) be recreated precisely in the word processor of your choice.
The layout of course papers and prospectuses look similar to the formatting of the final theses
not simply for aesthetical considerations. As their text may end up as a part or even chapter of
your thesis, it is advisable to use the same settings throughout your studies to avoid wasting
precious research and writing time with tweaking layout and font issues..
Apart from the header text, the following settings are identical with the guidelines for course
papers and prospectuses. They are repeated below for easier reference.

Margins
Click the Page Layout tab on the tool bar:
Select Margins,
Set the Top, Bottom, Right and Left margins to 1” (inch)
If the measurement is in centimeters, you can set it to inches:
File tab > Options > Advanced tab > Display
Set the Gutter measurements to 0.

Jorge Cham, PhD Comics, March 28, 2007, accessed July 20 2015.
http://www.phdcomics.com/comics/archive.php?comicid=842

Language
Make sure to use English (preferably US) as the language setting, normally in the lower left of
the screen.
Please note that setting the language to English, besides being useful for the autocorrect option, is also essential for punctuation. For example, only the so-called ‘smart
quotes’ (“curly” upper quotation marks and apostrophes) are acceptable as quotation
marks, which normally vary widely across other languages.
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Your quotation marks may be auto-corrected to non-standard if your language is set to
a language other than English. You can avoid non-standard quotation marks by setting
the language to English either by setting it as default as above or manually by
highlighting the desired passage. This is especially important for footnotes.

Font
Go to the Home tab on the tool bar.
In the Font section, click on the tiny arrow in the bottom right to open the dialogue box
or use buttons.
Set the Font to Times New Roman,
Set the Font Style to Regular (i.e. not bold, italics, or underlined),
Set the Size to 12.

Spacing, Alignment and Indentation
Go to the Home tab on the tool bar.
In the Paragraph section, click on the tiny arrow in the bottom right to open the
dialogue box:
Set the Alignment to Justified,
Set the Indentation (Right and Left) to 0,
Set the Spacing:
‘0’ (Before and After) for ordinary text
‘12 After’ for bibliographies,
Set Outline Level to Body Text.
Set Line Spacing:
Double for ordinary text,
Single for bibliographies.
Do not use tabs and spaces for indenting and block quotes.
For texts and bibliographies, use Special indentation.
First Line for ordinary text,
Hanging for bibliographies.
If you have a quotation in your text that is more than three lines long, the
quote should be given as a block quote: single-spaced, and indented 0.5 inches
on the left and right. The spacing is still 0.
Highlight the text you want to alter and then change these settings; they should
change back automatically when you return to the regular text.
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Footnotes and Bibliography
Footnotes
At the first mention of the article, use the Insert Footnote command under the References
tab to place a footnote at the bottom of the page; use Arabic numbers, do not use endnotes.
Format your footnotes following the Chicago style.
It is NOT department style to use embedded references (also known as Harvard or authordate system providing name, date, and page numbers within the body of the text) or
endnotes -- these are forms that tend to be used in the natural and social sciences.
See more in the Footnote Formulations section below.

Bibliography
The purpose of a bibliography is to identify the works you have consulted, to make clear that
you have indeed seen the works, and to enable your reader to find them. Do not prepare a list
of recommended readings: include only sources you have actually cited.
One of the hallmarks of an accomplished scholar is their ability to prepare a bibliography
consistent with an assigned style, for a publication or, in this case, for a department.







Do not number the items on the bibliography. Arrange them alphabetically by author
or editor or title (the first item in the citation).
Do not group items in categories such as books, articles, etc. Integrate all the sources.
Divide the items into two groups with the headings ‘Primary Sources’ and ‘Secondary
Sources.’
Either use the thesis formatting template provided by the Computer and Statistics
Centre’s e-learning page or set it manually to single spaced with a 12pt space after
paragraphs (See Spacing, Alignment and Indentation above).
Use hanging indention (See Spacing, Alignment and Indentation above).

See more in the Bibliography section below.

1.2 Spell check

Under the Review tab > Spelling and Grammar you can set the computer to check your
spelling and grammar in Word. This is a good way to check your typing as you go because it
picks up double or missing spaces.
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Word checks spelling (with red underlining), but the computer does not know everything; it
cannot spell iconologic or toponym, so do not let it get the upper hand. If you use such words
frequently, right-click the word and either add to your dictionary or mark it as ‘ignore all’ to
avoid annoying red underlining.
The computer also checks grammar and looks for punctuation mistakes and sentences that are
in the passive voice, fragment (missing verb) or too long, among other things (green
underlining).

1.3 Computer-aided revision
Microsoft Word offers a number of features that make it possible to speed up revision and rewriting. You can use Find and Replace in the Home tab to change errors that you have made
more than once or to check that you have been consistent in spelling and/or punctuation.
The most important electronic correction system that we use in Academic Writing is Track
Changes (under the Review tab). This allows instructors to comment on your writing and
make suggestions for changes in different colors on the screen. You can see what we suggest
and then decide whether you want to accept our suggestions or not. If you accept them they
will be automatically incorporated in your paper, if you reject them the paper will revert to the
way you originally wrote it.
You can accept/reject single corrections by right clicking on the corrected feature and selecting
the command from the drop down menu. Alternatively, you can accept/reject all corrections at
once in longer passages, by highlighting the passage and click on the Accept or Reject button
in the Review tab. If you accept a change the colored text will disappear and the corrections
will be replaced by regular black type. If you reject a change the text will revert to the original
form.
There are two forms of Track Changes notation: with and without balloons (comments
on the margin). In one form revisions and corrections appear in the text, in the other
form they appear as comments in balloons in the right margin. You can make the
content of the balloons appear in-line by clicking on Show Markup under the Review
tab and selecting Balloons > Show All Revisions Inline. If you choose the latter, please
make sure to edit your text and remove anything redundant or repetitive from your final
version.

1.4 E-mail and E-learning
At CEU we often use email to contact each other and share information. We count on each
other to read our emails and respond appropriately. That means that if a professor or staff
member writes to a student they expect a response. Check your CEU mailbox often, but at least
once a day, and if you get an email, send an answer, even if it is just “Okay” or “Thanks for
the information.”
9

If there is no response the sender does not know whether the message got lost or whether the
person it was sent to is just ignoring it. If you receive a group message there is no need to
respond unless it asks for specific information from you.
CEU’s central e-learning site will be an important part of your studies. Besides serving
administrative functions and providing a platform to share information with staff and fellow
students, it is where you will find the most up-to-date versions of syllabi, templates and
readings pertaining to classes you have registered for.
http://ceulearning.ceu.hu/
As the contents of the site is complex, changeable and authored by a large number of people,
please make sure you report inconsistencies and dead links to the author of the document(s) in
question.
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2. Thesis Writing Seminar: Assignments
2.1 Critique of a Previous MA Thesis
In the MA Thesis Seminar I you will be asked to review and critique [pronounced krit-EEK] a
thesis previously produced in the department. You may select a thesis on a topic similar to the
one you wish to pursue, or a thesis with a methodology similar to that you will use, or some
other topic of relevance for your research. The purpose of this assignment is for you to take an
in-depth look at a thesis from this department, to see what constitutes good scholarly research
and presentation, and to get ideas of what to do and what to avoid in your own work. Feel free
to apply the critical reading techniques you learned in the Academic Writing course.
Each critique will be presented orally to one of the MA seminar groups and then the other
seminar participants (students and faculty) will ask questions.
Each presentation will last 10-12 minutes, no more. The presentation should have three parts:
Part I. A short description of the thesis. This should be a brief overview describing the source
material and methodology.
Part II. A statement of the main point of this thesis, followed by a brief evaluation of its place
in the scholarship on this topic.
Part III. A critical evaluation of the whole work. There are several questions you might
address, depending on the thesis. You need not answer all of these, or you might add others.
It is quite acceptable to give your opinion of the thesis, just support your criticisms (or praise)
with examples.


How much and what kind of evidence supports the main point?



How persuasive is the evidence?



Do the data fit or support the conclusions?



Can you offer counter-arguments or refutations of the evidence?



Does the thesis do everything it promises in the introduction?



Are the conclusions logical?



Why did you like or dislike it?
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2.2 Writing your MA Thesis Outline1

The distinguishing mark of graduate research is an original contribution to knowledge, which
is demonstrated in the thesis. To this end, your thesis must show two important things: that
you have identified a worthwhile question or source that has not been adequately studied
previously, and that you have answered the question or expanded the understanding of the
source material. This is your contribution to knowledge.
An outline is:
A logical, general description
A schematic summary
An organizational pattern
A visual and conceptual design of your writing
Before you begin:
Develop the central question of your thesis; state the subject as a question.
Not: I would like to study the cult of saints.
Phrase the subject as a question or a series of logically connected questions: Why was
Soandso made a saint? Whose interest did it serve? What were its political and social
implications?
Think about your audience; it is not only the top three experts in your field, but medievalists
and others with an interest in your topic and some background knowledge.
Brainstorm: List all the ideas that you might want to include in your paper. Write ideas on little
slips of paper and experiment with different arrangements or use a cluster or “spider web”
diagram to see how your ideas are related. Use mindmapping software or Prezi if you are
familiar with them.
An outline has a balanced structure based on
Parallelism: Whenever possible coordinate headings should be expressed in parallel form, that
is, nouns should be made parallel with nouns, verb forms with verb forms, adjectives
with adjectives, and so on.
Coordination: Those items that are of equal significance should have comparable numeral or
letter designations: a Chapter A is equal to a B, a Section 1 to a Section 2, a sub-section
a to a subsection b, etc. Coordination helps you maintain a coherent and consistent
document. Use Microsoft Word’s Numbering feature to anchor the hierarchy of your
skeleton structure into a linear system.

1

Adapted by Judith Rasson, based on materials from: H. Ramsey Fowler and Jane E. Aaron, The Little, Brown
Handbook (Boston: Pearson, 2016), and the websites of the Purdue University Online Writing Lab (OWL) and
John W. Chinneck at https://owl.english.purdue.edu/owl/ and http://www.sce.carleton.ca/faculty/chinneck/thesis.
html.
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Subordination: In order to indicate levels of significance, an outline uses major and minor
headings. Thus, in ordering ideas you should move from general to specific or from
abstract to concrete - the more general or abstract the term, the higher the level or rank
in the outline. This principle allows your material to be ordered in terms of logic and
requires a clear articulation of the relationship between component parts used in the
outline. Subdivisions of each higher division should always have the same relationship
to the whole.
Form: The most important rule is to be consistent. An outline can use either sentence structure
or topics. A topic outline uses words or phrases for all entries and uses no punctuation
after entries. A sentence outline uses complete sentences for all entries and uses correct
punctuation.
Your research question is the controlling idea of your research paper. Ensure that your outline
reflects your question.
An Outline
1. Introduction
This is a general introduction to what the thesis is all about – it is not just a description of the
contents of each section. Briefly summarize the object of your research, some of the reasons
why it is a worthwhile question, and perhaps give an overview of your main results.
2. Primary Sources
Here you list the primary sources that will be the basis of the thesis. They might be texts or
items of material culture or images. The details of these sources appear in the preliminary
bibliography that accompanies the outline.
3. Brief Review of Previous Research
Give a specific title. Here you review the state of recent scholarly literature relevant to your
thesis. You organize this section by idea, and not by author or by publication. The various ideas
form the subheadings on the outline.
4. Background Information (optional)
Give this section a number and a specific title. A brief section describing how your
interdisciplinary work bridges two (or more) areas of medieval studies.
5. The Research Question
Give this section a title that includes the word “question” or “problem.”
This section has three main parts: a concise statement of the question that your thesis tackles;
justification, by direct reference to Section 3, that your question is previously unanswered or
your source is insufficiently studied, and a discussion of why it is worthwhile to answer this
question. What will be the benefits to scholarship on this topic?
6. Methodology
13

Give this section a descriptive title.
Describe how you will solve the problem or answer the question. The techniques you use may
be description, classification, comparison and contrast, analogy, cause-and-effect analysis, the
analysis of a process, or something else. Briefly mention what data you will analyze.
7. Conclusions
Conclusions are not a rambling summary of the thesis: they are short, concise statements of the
inferences that you have made because of your work. All conclusions should be directly related
to the research question stated in Section 5. You generally cover three things in this section,
usually each topic in a separate subsection: conclusions, a summary of your contributions to
knowledge, and suggestions for future research. When you present your outline you probably
do not yet know the conclusions, so just suggest what they might be in one or two points.
The outline is both a plan for your thesis and an organized description of your expected research
findings; it helps you organize your material. It shapes your information into a pattern and
shows the relationships among ideas that you can understand and follow as you write your
paper. Since your ideas are already logically arranged, the actual writing of your paper will be
much easier. An outline, however, is just a preliminary plan; since writing is a creative process,
your outline and paper will change and improve as you gain more knowledge on your research
topic.
Your ability to write may surprise you. Be open to surprises. Writing is thinking. The more
you think about something, the more you see.

2.3 Bibliography Assignments
During your thesis research and other projects, it is recommended to maintain an impeccable,
consistent, complete and constantly updated bibliography and not leave it for the last minute
because that is a sure way to lose your mind and get lost in minute detail at a time you should
be revising your thesis - or even fail with an otherwise passable thesis on the grounds of
unprofessional formatting, technicalities, or the suspicion of plagiarism due to insufficient
referencing. Make a habit out of recording all publication data including page numbers and
minor details as you progress with your research and store this information in a safe and
retrievable way. It is recommended to use referencing software, such as Endnote or Zotero,
which can handle massive amounts of data reliably and precisely.
During the course of your studies at CEU you will be asked to submit sample bibliographies at
various stages of your research. This is to ensure that you can master the art of efficient and
precise academic referencing and it is also hoped that these assignments will inspire you to
select, consider and manage your sources carefully from the beginning to the end of your
studies. These assignments should always be formatted as the final version to be included in
your thesis.
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2.3.1 Preliminary Bibliography
During the MA Thesis Seminar I course students are required to begin to work on their
bibliographies. A Preliminary Bibliography is prepared by one-year MA students to
accompany the outline presentation in the MA Thesis Seminar I. After the seminar meeting,
both the outline and preliminary bibliography are to be revised. The Preliminary Bibliography
will be graded to help you master the Chicago style (and the departmental adaptations).
Compile a list of at least 3-8 primary sources (depending on your research topic) and a list of
at least 10-15 secondary sources that you think you will be using for your research topic. Using
The Chicago Manual of Style bibliographic patterns from this reader and the Chicago Manual
of Style on-line (http://www.chicagomanualofstyle.org) create an initial working bibliography
of these works either manually or by the citation management software of your choice
(recommended).
For formatting and layout questions, as well as basic guidance on citations, see the
Bibliography section below.

2.3.2 Annotated Bibliography
An Annotated Bibliography is prepared by Year Two students in the two-year MA program
during the summer prior to the beginning of their second year. It needs to contain at least ten
items, out of which primary sources may be ones that were in your original prospectus
bibliography, but the secondary sources need to be new, i.e. not in the original prospectus.
Ideally these are works you discovered or consulted over the summer.
Details of this assignment are communicated to students at their prospectus defense. The aim
of this exercise is to deepen the students’ familiarity with their sources and encourage research
activities during the summer, especially for students whose research requires travelling to
archives or libraries outside the academic year.
An Annotated Bibliography is a list of secondary sources (or critical editions of primary
sources), which provides descriptive and critical details about the publication. The length and
style of each annotation varies according to the purpose and audience for the Annotated
Bibliography, but most annotations are written in complete sentences and fall between 50-150
words. Depending on length and purpose, an Annotated Bibliography may be just a list of
alphabetized entries (as in a normal bibliography), or it may be categorized by subject, material
type, time period, etc.
Details typically include a general description of the work, context (if relevant) and any critical
observation or notable characteristics you wish to note:
15






Brief description/summary of the work cited
Comments about the work’s relevance or quality, which may include
o the scope or relevance of the work
o the intended audience
o the author’s credibility or expertise
o the work’s relationship to other works in the area of study
Comments about any special features of the work, if necessary or relevant (graphs,
charts, appendices, etc.)

According to Chicago referencing style, “annotations may a simply follow the publications
details or may start a new line, often with a paragraph indention.”2 According to Turabian,
“annotations should begin on a new line with a paragraph indention.” 3 Although both are
acceptable, for legibility reasons, I suggest the so-called hanging indent.
Please note that at CEU, there is also a requirement to include at least a sentence about the
relevance of the publication in your own work, for example:
Pagan roots
Benko, Stephen. The Virgin Goddess: Studies in the Pagan and Christian Roots of Mariology.
Leiden: Brill, 1993.
Benko studies extra-biblical sources of Marian piety and doctrine to suggest that there
is a discernible continuity from ancient goddess-cults to the cult of the Virgin Mary.
The book is strongly focused on the feminine aspect of the divine and the role of the
female in the history of salvation from a Christian viewpoint. This work can be an
important thread in the theological contextualisation of the role Pagan goddesses in the
age of Christianisation in the Baltic region.
Davidson, Hilda Ellis. Roles of the Northern Goddess. London: Routledge, 1998.
Davidson's book provides a thorough examination of the major roles filled by pagan
goddesses of Northern Europe in everyday life, including their roles in hunting,
agriculture, domestic arts like weaving, the household, and death. The author discusses
relevant archaeological evidence, patterns of symbol and ritual, and previous research.
The book includes a number of black and white photographs of relevant artefacts, which
I will be using in the section of comparative examples (cf. the Baltic examples I
recorded) in Chapter 2 of my dissertation (provisional).

2.4 Thesis chapter
Students are required to present their first analytical chapter in the format detailed below. The
chapter and other required texts must be submitted in a single file in .doc format for language
check one week prior to the presentation. This must contain the following elements:

2
3

Chicago Manual of Style, 15th ed., 613.
Kate L. Turabian, A Manual for Writers of Research Papers, Theses, and Dissertations, 7th edition, 148.
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1. Front matter
This is contained in the Thesis Template available at the CEU Computer and Statistics
Centre’s e-learning site:
CEU Home ► Courses ► Computer and Statistics Center ► Thesis Submission
This is pre-programmed and contains all the text and header styles necessary for your work,
including the mandatory front matter, table of contents and appendices, so you can save it on
your computer and type your text directly in it.
The Medieval Studies and Comparative History thesis templates are slightly different. When
compiling the final version of your thesis please make sure you use the correct template.
2. Provisional Table of Contents or Outline
Provide brief information about the provisional table of contents and where the chapter
submitted fits in your planned structure. Bulletpoint structure is sufficient. Use appropriate
heading styles provided in the template to be able to create your table of contents automatically.
3. Chapter
The chapter presented must be an analytical chapter, which means that it is NEITHER a literary
review / background chapter, NOR the introduction / conclusion. The chapter submitted must
be written up with appropriate referencing provided in footnotes. See footnote formulation
guidance in the Footnote Formulations section below. Make sure you provide the title for your
chapter.
4. Bibliography
An appropriately formatted bibliography must be provided containing all references cited in
the chapter submitted. See bibliography formulation guidance in the Bibliography section
below. Make sure you provide the title for your chapter.
Please note that your Powerpoint presentation should not contain slides of dense text captured
from your chapter, but rather summarise the place of the submitted chapter within the entire
thesis, the main sources, argument, interim conclusion and indication how this fits in with the
final conclusions of the thesis. You may include graphic representations of your argument or
any maps and pictures you will insert or describe in your text.
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3. Footnotes
3.1 The Chicago Manual of Style / Turabian
The Departments of Medieval Studies and History follow The Chicago Manual of Style and its
abridged version adapted for postgraduate students by Kate Turabian.
If you are using Zotero, Endnote or other referencing tools, set Chicago / Turabian as
the default referencing style.
If you prefer to create and maintain your bibliography manually, consult the Chicago
Manual of Style on-line: http://www.chicagomanualofstyle.org/tools.
Please note that off campus you will need to install Cisco AnyConnect Mobility Client
VPN on your computer and connect to CEU to be able to access this tool. Follow the
instructions on the library webpage: http://www.library.ceu.hu/vpnh.htm.
You will note that books, collected works (edited books), and journal articles differ on several
important points, especially on the location of page numbers in the citation. To be able to use
the style guide appropriately, you should be able to “diagnose” the work for which you are
preparing an entry and figure out which format to follow.



Please be advised that regarding certain questions of translation and transliteration of
foreign titles and names in footnotes and bibliography, the Department of Medieval Studies
follows guidelines somewhat different than the Chicago / Turabian style, so you will be
required to be able to make certain adjustments manually.

3.2 Differences between Footnotes and Bibliographies
Footnotes

Bibliography

References to support specific points in the text

A finding aid for works that are cited in the
footnotes and text
Bibliographic units separated by periods (full
stops)
First named author’s names given as: Last name,
First name.
Publication data for books not in parentheses

Bibliographic units separated by commas
Authors’ names given as: First name Last name,
Publication data for books in parentheses
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Page numbers come at the end of the reference

Page numbers do not always come at the end of
the reference
Page numbers for items from a collected work Page numbers for an item from a collected work
come at the end of the entry
follow the editor’s name and precede the
publication data
An item may be referenced more than once
An item is referenced only once
If an item is cited more than once, the first An item is cited only once
citation is in full and in subsequent citations a
short form is used specifying only the last name,
short title, and pages
A colon precedes the page numbers of journal A colon precedes the page numbers of journal
articles
articles
Abbreviations ed., tr. (meaning “edited by” or
“translated by”) are used for editor and translator
Full stops (periods), commas, and semi-colons
stand to the left of quotation marks

Abbreviations ed., tr. (meaning “edited by” or
“translated by”) are used for editor and translator
Full stops (periods), commas, and semi-colons
stand to the left of quotation marks

p. or pp. is not used to indicate pagination

p. or pp. is not used to indicate pagination

3.3 Footnote Formulations

Footnotes are not an invention of the devil. Along with bibliographies, they are a useful and
necessary part of scholarship. The formatting of footnotes varies with different styles (our
department uses the Chicago Manual of Style standards), but the content of footnotes in any
style complements the text in various ways.
The following guide is especially recommended if you choose to manage your citations
manually (i.e. not using Endnote or Zotero). However, footnotes are not always simple citation
devices: it is helpful to peruse this section even if you use citation management tools because
understanding and knowing the basic tenets of citation and textual notes is one of the
fundamental transferable skills that will come handy in your future career.
Insert footnotes in your text by the word processor’s automatic insert footnote function (under
the Insert tab), do NOT attempt to type them at the bottom of the page manually.
Use Arabic superscript numbers, which is the default setting in most word processors.
Superscript numbers are automatically smaller than the rest, so there is no need to further edit
the font size.
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How to insert footnotes in a Word document

Place the footnote number at the end of the sentence, after the full stop (period) with no space
between them. Only place footnote numbers inside a sentence if you have several footnotes
referring to different parts of a sentence, such as items in a list.
For example:
According to Gunther Barth in Bitter Strength: A History of the Chinese in the United States,
1850-1870, “[t]he term coolie which originally designated any hired labourer, porter, or
carrier came to describe one pressed into service by coercion.”1

3.4 Types of Footnotes
Footnotes can comprise of information ranging from simple references to complex subchapters
with internal references, translated passages and quotations. Keep your punctuation consistent
and very clear. The following two sections Complex Footnotes and Reference-only Footnotes
give you an insight into various types of material that may be placed into footnotes.
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Even the most accomplished scholars run into rookie errors every now and then: "Not sure how this made it
through proofreading, peer review, and copyediting.” David Jay Harris on Twitter, November 10, 2014, accessed
on 20 July 2015, https://twitter.com/davidjayharris.

3.4.1 Complex Footnotes

Footnotes can comprise of information ranging from simple references to complex subchapters
with internal references, translations and quotations. Do not have line breaks within one
footnote and keep your punctuation very clear.
There is no ideal length for a footnote and the average length and nature of footnote varies
across discipline and even within one thesis. However, an overlong footnote disrupts the page
layout and raises suspicion that the material therein may be better in the main text or an
appendix.

Summary of literature on a certain question:
64

See Józefowiczówna, 51-63. For the fourteenth-century sepulcher she quotes the account
of Jan Długosz. She also discusses archaeological finds of earlier sepulchral structures that
attest to the existence of the royal tombs in the central nave of the cathedral before the raid
on the cathedral in 1034-1038. Moreover, this author places the supposed royal tombs
erected in medio ecclesiae within broader Western European burial customs. See also
Benešovská for a comparative study of royal tombs in France, Germany, England, and
Bohemia.

Explanation of certain terms used in the text:
“Full” noble status may be taken as those rights which appear in the 1514 Tripartitum,
Pars I, Tit. 9, such as habeas corpus, freedom from taxation in exchange for military
service, and political participation: Sándor Kolosvári and Kelemen Óvári, ed., Werbőczi
István Hármaskönyve [The Tripartitum of Stephen Werbőczi] (Budapest: Magyar Irod.
Intézet és Könyvnyomda, 1897), 64-68.
7

Clarification, explanation:
Sometimes additional clarification or background information about certain concepts is
necessary, but would clutter your text or disrupt the flow of your argument if left in the body

21

of text. This type of footnote does not necessarily contain references, they are part of your own
text transposed outside the frame of the page for easier reading.
11

As far as their language was concerned, later evidence indicates that they were using
Romanian; however, many of them became Roman Catholics, in contrast to their previous
Orthodox beliefs, which remained dominant among most of the Romanian population.

Size does matter: do not write a book within a book. Monster-footnote found in Allan Mallinson, Too Important
for the Generals: Losing and Winning the First World War (London: Bantam Press, 2016), 181.

Outdated Literature Not in Text
When the literature of certain concepts of topics looks back on too long a history to efficiently
summarize in a few paragraphs, some of the more obvious or lengthy works may be relegated
into a summary footnote that combines references with short annotations.
3 Many of the written sources on this topic were published more than a century ago and
later repeatedly republished or included in different source collections edited in
Hungary and Romania. The main source collections for this subject are: Frigyes Pesty,
ed., A Sörény vármegyei hajdani oláh kerületek [The former Valachian districts of
Severin County], vol. 3 (Budapest: MTA, 1878); Frigyes Pesti, ed., Krassó vármegye
története, vol. 3, Oklevéltár [The history of Caraş County, vol. 3, Diplomatarium]
(Budapest: Athenaeum, 1882); Eudoxiu Hurmuzaki and Nicolae Densuşianu, eds.
Documente privitoare la istoria românilor [Documents regarding the history of the
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Romanians] vol. 1, bk. 1-3 (Bucharest: Socec, 1890-1911); E. Lukinich, L. Gáldi, and
L. Makkai, eds., Documenta historiam Valachorum in Hungaria illustrantia usque ad
annum 1400 p. Christum (Budapest: MTA, 1941); Mihail Berza, et al., eds.,
Documenta Romaniae Historica, C Transilvania, vols. 10-13 (Bucharest: Editura
Academiei Române, 1977-1994); Costin Feneşan, ed., Documente medievale bănăţene
1440-1653 [Medieval charters from the Banat 1440-1653] (Timişoara: Facla, 1981).
The scholarship on this subject encompasses a wide range of works and studies that
approach different aspects of the history of the Romanian elite, knezes or nobles in the
Banat. Among the most important authors are: Frigyes Pesty, Gheorght Vinulescu,
Ioan Vuia, Victor Mogogna, Maria Holban, Costin Feneşan, Viorel Achim, Ioan
Haţegan, Dumitru Ţeicu, Ligia Boldea, Ioan Drăgan, Ioan-Aurel Pop, and Adrian
Andrei Rusu. A list of their contributions would overburden this short review.

Original Text of Translated Passages
Footnotes provide the original language of a quotation translated into English in the text and
English versions of Latin, Greek, Church Slavonic, and other languages where the quotes in
the text are in the original language.
The source of the translation is noted (usually in the text) as (my translation) or (translation by
[the author of a standard translation, with the full reference].
Foreign language originals appear in italics without quotation marks, followed by the reference
to the source:
34

Item similiter lego viginti quinque florenos ad unum indumentums altaris, quod fiat
ad . . . maius altare de alba kamwka, item lego florenos quinque pro uno alio indumento
sacerdotali ad . . . ecclesiam Fratrum Minorum, quod fiat de nigro atlasio wlgo atlacz
in memoriam defunctorum, quod consistit in . . . ecclesia Fratrum minorum sine
organo, KvOkl, vol. 1, 373, cp. Entz 1996, 148-149, 340. For the kamuka and atlasz,
see Walter Endrei, Patyolat és posztó [Cambric and cloth] (Budapest: Magvető
Könyvkiadó, 1989), 216, 227.
English translations appear non-italicised with quotation marks, followed by the reference to
the source:
“Take the roots of madder while it is green, and make them clean; and then anoint
them with honey, and sprinkle powder of madder on them, and make a suppository
thereof; and it shall make a woman have her terms, and to be delivered of a dead child
and of the afterbirth.” Translation in Warren R. Dawson, A Leechbook or Collection of
Medical Recipes of the Fifteenth Century (London: Macmillan, 1934), 97.
73
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Meta-research notes: gratitude, research circumstances or source
limitation
Although gratitude is best expressed in the acknowledgments page, when relevant, footnotes
may be the right place for acknowledging informal sources.
1

I would like to express my special gratitude to János Bak, Ioan-Aurel Pop, and Pál Engel
for the invaluable help provided during the elaboration of this study and to Mary Beth Davis
for improvements to the language.
Sometimes external circumstances affecting primary sources or methodology may be included,
but your thesis is not a place for ironic or sarcastic points to be made about lack of grants or
access to important collections. These mitigating circumstances are important, but use neutral
phrases and an impersonal, matter-of-fact tone.

Our excuses for not consulting all available manuscripts have come a long way.
Preface from Heinrich Oskar Sommer, The Vulgate Version of Arthurian Romances, vol. 1 (Washington: Carnegie
Institution, 1909).

Disagreements, Side Issues
In order to maintain the flow of your argument and avoid disruptions and digressions you may
need to place in a footnote certain pieces of background information or note the existence of
views in previous scholarship conflicting with yours.
17

The author does not consider several significant sources and gives a dubious
interpretation of the written records: 1) in relating murals from Trakai with the Biblical
24

cycle of David and Joseph, the author does not follow either the sequence of the
pictures, alternating between the first and second floor, nor is she acquainted with their
descriptions; 2) relating the wall-paintings to Vytautas’ intended coronation cannot be
justified because it is based on an erroneous iconographic interpretation and on the
travelogue by Ghillebert de Lannoy. According to the travelogue, Ghillibert de Lannoy
visited Vytautas twice during the winter, in 1414/14 and 1421. He described both of
his visits in great detail. During his first visit, Ghillibert passed by Trakai and wrote
about the city and the castles, but was silent about the murals. Róźycka-Bryzek thinks
that this silence suggest the absence of the murals; however, there is no basis to argue
that Ghillibert ever entered the palace. For the passage in the travelogue, see “Ištraukos
iš ‘Voyages et Ambassades,’ kur kalbama apie Lietuvą” (Excerpts from ‘Voyages et
Ambassades’ concering Lithuania), appended to P. Klimas, “Ghillebert de Lannoy; dvi
jo kelionés Lietuvon Vytauto Didžiojo laikais (1413/14 ir 1421 metais) [Ghillebert de
Lannoy: His two journeys to Lithuania during the times of Vytautas the Great (in
1413/14 and 1421)], Praeitis 2 (1933), reprinted in Lietuvių tautos praeitis/Lithuanian
Historical Review 4, no. 3-4 (1980): 253-56.
Their arguments are as follows: There is no evidence that Głowacki ever visited Lithuania.
The other drawings from Trakai correspond to Smokowski’s essay on the visit, the arrangement
of the sketches is close in form and sequence to a lithograph made after Smokowski’s drawings,
Stanislovas Mikulionis and Vytautas Levandauskas, “Trakų pilių ir miesto ikonografija
Krokuvos tautiniame muziejuje” [The iconography of the city and castles of Trakai in the
National Museum of Cracow], Architektūros paminklai 13 (1993): 68-70.
11

15 However, the fact that place names based on pure personal names were formed in the
early Árpád age has been questioned. Kristó claimed that such precision in dating is
not possible; Gyula Kristó, “Szempontok korai helyneveink történeti tipológiájához”
[Aspects of the historical typology of our early place names], Acta Universitatis
Szegediensis de Attila József nominatae. Acta Historica 55 (1976): 38.

Footnotes to Acknowledge Unpublished Material
16

The excavations directed by Kazimir Popkonstantinov from 1982 to 1987 identified four
main phases in the development of the monastic site. The “church of Mostič” belonged to the
third phase. I would like to thank Professor Popkonstantinov for providing me with the
unpublished documentation from his excavations.
51

According to László Dávid, the master-mark on the keystone of the church can be related to
the late fifteenth-century master-marks in the churches of Nagyszeben (Sibiu) and Brassó
(Braşov).
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Clauses of Concession

Footnotes can provide a clause of concession; not a contrasting view, but a comment that starts
with albeit, although, or whereas.
It has to be noted that an argument for the high clerical status of Mostič is a tomb found
empty 3.5 m north of the apse of the church. It is interpreted as the primary tomb of Mostič
for two reasons. First, the dimensions of the brick tomb (2.10 x 0.50 x 0.42 m) correspond to
two slabs the size of the slab of the burial inscription of Mostič; and second, the peculiar
trapezoid concavity designed at the bottom of the tomb, which reminds one of the Byzantine
custom of burying high-ranking clerics, i.e., bishops and abbots, in a sitting position. However,
it has to be admitted that these two characteristics of this tomb are not sufficient to prove that
the primary burial of Mostič was there: K. Popkonstantinov, “Văprosi okolo groba,” 268-71;
J. Kyriakakis, “Byzantine Burial Customs: Care of the Deceased from Death to Prothesis,”
GOThR 29, no. 2 (1984): 55.
25

3.4.2 Reference-only Footnotes
These are added at the first mention of an author or work. Such footnotes document that you
are familiar with the relevant literature and contain all publication data in footnote formatting.
The page range for articles and component parts of edited volumes are not included, instead
the number of the page cited in the text is given.
The basic form of a footnote citation is similar to that of a bibliographic citation. However,
footnote units are separated by commas rather than by periods, and publication details appear
within parentheses. An author’s given name appears before his/her surname or family name.
Page references are preceded by either a colon (for a journal) or a comma (for a book).
27

Rita Copeland, Rhetoric, Hermeneutics and Translation in the Middle Ages
(Cambridge: CUP, 1991), 34-36.
28
Aubrey Cannon, “Spatial Narratives of Death, Memory, and Transcendence,” in The
Space and Place of Death, ed. Helaine Silverman and David B. Small (Arlington, VA:
American Anthropological Association, 2002), 191-200.
29
Leo Ferrari, “Augustine’s Cosmography,” Augustinian Studies 27 (1996): 132-80.

See more in the Books and Journal articles section below.

Recurring References
The inclusion of a bibliography in a paper, just as in a thesis, does not change the requirement
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that a work should be cited in full in its first footnote entry. Second and subsequent references
maybe abbreviated in various ways to make the footnotes easy to read.
Be sure to use the same short form in each subsequent citation.

Abbreviated reference
A complete footnote citation need only be given on the first occasion that a particular work is
cited in a paper or thesis; thereafter, the footnote entry can be abbreviated to give only the
essential details – such as author’s surname, title, and relevant pages.
There is no need to use the form “hereafter: [short title]” except to avoid confusion.
Here are some examples of appropriate forms of abbreviation for both primary and secondary
sources:
First note: Alcuin, The Bishops, Kings, and Saints of York, ed. P. Godman (Oxford:
Oxford Medieval Texts, 1982).
Second and subsequent notes: Alcuin, Bishops, 36. [the page number]
No translation or transliteration of title is necessary. Initial definite article may be omitted. Do
not abbreviate titles by fragments or randomly chosen phrases out of the full title. For example:
Radoslav Katičić, “Aedificaverunt Ragusium et habitaverunt in eo: tragom najstarijih
dubrovačkih zapisa” [Tracing the oldest texts of Dubrovnik], Starohrvatska prosvjeta 18
(1988): 5-38.
39
Katičić, “Aedificaverunt Ragusium,” 36.
39

*NOT Katičić, “Aedificaverunt,” 36.
*NOT Katičić,“Tracing the oldest,” 36.
For certain sources, particularly published materials that are widely referred to by acronyms, it
is possible to use an acronym as a form of citation (after a full citation in the first footnote
entry) and to indicate this to the reader by using ‘henceforth’ or ‘hereafter’.
Use this only if you cite the source more than five times in a chapter.
30

Samu Barabás, ed., Székely oklevéltár 1219-1776 [Székely charters 1219-1776],
Magyar Történelmi Tár 28 (Budapest: Magyar Tudományos Akadémia, 1934)
(henceforth: SZO).
31
Archivio di Stato di Venezia, Cancelleria Inferior, Cart. 231 (Nicolaus de Varsis).
Hereafter: ASV. CI. Cart. 231.
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List of Abbreviations
An alternative to indicating abbreviations during the course of your thesis is to construct a list
or table of abbreviations of the most frequently cited manuscripts and sources, and to place this
at the beginning of your thesis. It can be inserted again at the beginning of the bibliography.
It is not necessary to include specific volume numbers and publication data in the list of
abbreviations as the abbreviations only concern the title. These data will be cited in detail in
the bibliography entry.
Abbreviations can be presented in list form or in a box as follows:
Abbreviations
MGH
PSRL

Monumenta Germaniae Historica
Polnoe sobranie russkikh letopisei (Concise collection of Russian chronicles)

PL
PG

Volume in the series Patrologiae cursus completus, series latina, ed. J.-P. Migne
Volume in the series Patrologiae cursus completus, series graeca, ed. J.-P.
Migne

If “PL” is cited in your list of abbreviations, an appropriate footnote form is as follows:
Richard of St. Victor, Nonnullae allegoriae tabernaculi foederis, in PL 196 coll. 193201.
However, if you do not cite “PL” in your list of abbreviations, the complete footnote form is
required:
Augustinus, Opera Omnia, Patrologiae cursus completus, series latina 32-47, ed. J.-P.
Migne (Paris: J.-P. Migne, 1841-1857; facsimile reprint, Turnhout: Brepols, 19821993), coll. 345-356.
For more on this, consult the Patrologiae and Other Frequently Used Series sections.

Op. cit., loc. cit., ibid. and idem
For the sake of clarity, the Chicago style does not use op. cit. (opere citato) and loc. cit. (loco
citato), preferring citation according to the short-title form that has been set out above. Ibid. is
recommended to be used with restrictions only.
Note that these abbreviations are NOT italicized.
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Ibid. (ibidem) refers to a single work cited in the note immediately preceding. It may NOT
be used for any reference prior to the immediately preceding note, whether for another work
by the same author or the work actually cited.
Panos Sophoulis, “The Chronicle of 811, the Scriptor incertus and the ByzantineBulgar Wars of the Early Ninth Century,” Bulgaria Mediaevalis 1 (2010): 381.
18
Ibid., 383.
19
Ibid., 386.
20
Paul Stephenson:, “About the Emperor Nikephoros and How He Leaves His Bones
in Bulgaria: A Context for the Controversial ‘Chronicle of 811’,” Dumbarton Oaks
Papers 60 (2006): 87-109.
21
Sophoulis, “The Chronicle of 811,” 387.
17

24
25

See Hoffman, Die heiligen Könige, 16-58.
Ibid., 67; Graus, Volk, Herrscher und Heilige, 416-20.

Although Chicago style does not use ‘Idem,’ it is permissible to be used in place of an
author’s name in successive references within one note to several works by the same author.
However, it is recommended to simply write “and” to connect such works.
OK:
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Michael Clanchy, Abelard: A Medieval Life (Oxford: Blackwell, 1999), 54; idem,
England and its Rulers 1066-1272 (London: Fontana, 1983), 24.
RECOMMENDED:
26
Michael Clanchy, Abelard: A Medieval Life (Oxford: Blackwell, 1999), 54, and
England and its Rulers 1066-1272 (London: Fontana, 1983), 24.
Another common abbreviation used in notes is cf., confer, meaning “compare with.” For
clarity’s sake it is also recommended to be substituted by English phrases.

Multiple Citations
Footnotes can serve a variety of purposes and thus take a variety of forms. In addition to the
straightforward citation of a particular source, a footnote may be the citation of multiple
sources, perhaps with a linking commentary, or a narrative without any citations at all. The
latter does not concern us here. For multiple citations in a footnote, appropriate punctuation,
usually a semicolon, needs to be introduced between each individual source:
For example:
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42

Panos Sophoulis, Byzantium and Bulgaria, 775-831, East Central and Eastern Europe
in the Middle Ages 16 (Leiden: Brill, 2011), 23-32 and 184-216; Daniel Ziemann, Vom
Wandervolk zur Grossmacht: Die Entstehung Bulgariens im frühen Mittelalter (7.-9.
Jahrhundert), Kölner historische Abhandlungen 43 (Cologne: Böhlau, 2007), 247-63;
Theopahanes Confessor, Theophanis Chronographia I: Textum Greacum continens, ed.
Carl de Boor (Hildesheim: Olms, 1980), 490; commentary and translation in: The
Chronicle of Theophanes Confessor: Byzantine and Near Eastern History, AD 284813, trans. Cyril A. Mango, Roger Scott and Geoffrey Greatrex (Oxford: Clarendon
Press, 1997), 672-76.
Stephen Wessley, “The Thirteenth Century Guglielmites: Salvation through
Women,” in Medieval Women, ed. Derek Baker (Oxford: OUP, 1978), 289-303;
Giovanni Grado Merlo, “Guglielma la Boema: Tra santitá ed eresia al femminile,” in
Eresie ed eretici medievali (Bologna: Il Mulino, 1989), 113-18.
54

Note that when an article or chapter from an author’s work is cited, as in the Merlo example
above, the author’s name appears just once, at the beginning of the citation.
When an article is cited from a collected work with an editor, as in the Wessley example above,
both author and editor must be cited in the form shown.
Multiple citations within a narrative footnote can also be set out as follows:
34

For a detailed history of the cathedral building in its historical context, see Józef
Łukaszewicz, Krótki opis historyczny dawnej dyecezyi Poznańskiej (A short historical
description of the former Poznań diocese), vol.1 (Poznań: Księgarnia Żupańskiego,
1858). Archaeological excavations in the cathedral are discussed in Krystyna
Józefowiczówna, Z badań nad architekturą przedromańską i romańską w Poznaniu
(Research on the Pre-Romanesque and Romanesque architecture in Poznań), Polskie
Badania Archeologiczne 9 (Wrocław: Zakład Narodowy im. Ossolińskich, 1963).
A citation in a footnote can be incorporated within a full sentence, thus:
See here the opinion of Margaret Mullett, “Writing in Early Medieval Byzantium,” in
The Uses of Literacy in Early Medieval Europe, ed. Rosamund McKitterick
(Cambridge: CUP, 1992), 5, that “the functions of literacy need to be established in
relation to a particular society’s needs.”
2

3.5 Footnote Formatting

At the first mention of the article, use the Insert Footnote command under the References tab
to place a footnote at the bottom of the page; use Arabic numbers, do not use endnotes. Format
30

your footnotes following the Chicago style.
It is NOT department style to use embedded references (also known as Harvard or author-date
system) providing name, date, and page numbers within the body of the text or endnotes. These
are forms that tend to be used in the natural and social sciences.
The basic form of a footnote citation is similar to that of a bibliographic citation. However,
footnote units are separated by commas rather than by periods, and publication details appear
within parentheses. An author’s given name appears before his/her surname or family name.
Page references are preceded by either a colon (for a journal) or a comma (for a book).
See more in the Books and Journal articles section below.

3.5.1Translation of Titles
The titles of books and articles in all languages other than English must be translated by the
student and included in the bibliographic entry. The exceptions to this are the languages of
Greek, Latin, French, German, Italian and Spanish.
The titles of journals and series do NOT have to be translated. Place the translation directly
after the original title and enclose it in square brackets. The translated title is not italicized or
capitalised except for proper nouns like place-names (sentence style as opposed to headline
style).
The quotation marks for article titles enclose only the original title, which is followed by the
translation in square brackets and then the necessary punctuation. There is no punctuation
between the original title and the translation unless the title ends in a question mark or
exclamation mark.
Example for a book in a language that must be translated:
7

Erik Fügedi, Kimondhatatlan nyomorúság: Két emlékirat a 15-16. századi oszmán
fogságról [Unspeakable misery: Two memoirs on Ottoman captivity from the fifteenth
and sixteenth centuries] (Budapest: Európa, 1976).
Examples for articles in a language that must be translated:
Amedeo Molnár, “Theologie husitského kalicha” [The theology of the Hussite
chalice], Theological Supplement to the Christian Revue 1 (1965): 1-9.
65

Mahmut R. Gazimihal, “İstanbul Muhasaralarında Mihaloğulları ve Fatih Devrine
Ait Bir Vakıf Defterine Göre Harmankaya Mâlikânesi” [The Mihaloğlus during the
siege of Constantinople and their estate in Harmankaya according to a waqf register
from the reign of Mehmed II], Vakıflar Dergisi 4 (1958): 125-37.
19
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3.5.2 Transliteration
If a language is written in a non-Latin script, the title of the work is not transliterated (although
it is translated into English). The author’s name is used in transliterated form in order to
alphabetize it with the rest of the bibliography, but the name is also given in the original script.
The department follows the recommendations of the Chicago Manual that “linguistic”
transliterations be used, that is, Latin letters with accents or other diacritical marks (some
examples are: Č, Đ, and Ž) for any thesis containing texts. For purely historical or art historical
theses it is better to use the system of the U.S. Board on Geographic Names. Use only one
transliteration scheme throughout the thesis; DO NOT mix the systems. The formats for each
type of source are the same even if transliteration is necessary. The name of the place of
publication should be in English, especially if there are many variants. The publisher should
be given in the original alphabet.
For repeated references in the footnotes, use the author’s transliterated family name (as that is
how it appears in the alphabetical bibliography) and the first meaningful unit of the title in the
original script, followed by the relevant page numbers.
[Stevče Todorovski] Стевче Тодоровски, Археолошки наоди од среден век во
ареалот на Битола [Archaeological finds from the Middle Ages from the area of
Bitola] (Skopje: Macedonian Civilisation, 2002), 28.
84
[Todorovski], Археолошки наоди од среден век, 29.
83

34

[Hrachʻya Achaṙyan], Հրաչյա Հակոբի Աճառյան, Քննություն Վանի բարբառի
[Analysis of the dialect of Van] (Yerevan: University Press, 1952), 18-23, 40.
35
[Achaṙyan], Քննություն Վանի բարբառի, 39.
For complex translation and transliteration issues, always consult your supervisor and follow
their guidance. Let the academic writing instructor know about their preference if different
from above.

3.5.3 Quotations in Footnotes
When using a direct quotation in a footnote the quotation is preceded by a colon; the source is
given following the ending punctuation of the quotation:
One estimate of the size of the reading public at this time was that of Sydney Smith: “Readers
are … among the lower orders.” Letters, ed. Nowell C. Smith (New York: Oxford University
Press, 1953), 343.
1
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3.5.4 Medieval Names
In case of a medieval author’s name, the name-order does not have to be reversed. Thus,
Thomas Aquinas will be cited as such in both a bibliographic citation and a footnote, likewise
Nikephorus the Patriarch. However, if a saint’s title appears as part of the name on the title
page of the work, in the footnote the title will be cited first: e.g., Saint John Chrysostom, but in
the bibliography it will be alphabetized under J as John Chrysostom, Saint.
See in more detail in the Medieval Authors’ Names section below.

3.6 Different types of sources in footnotes
3.6.1Books and Journal articles
The reference units that comprise a footnote for a book are the following: Author’s given name
author’s family name, title of book [translation of title] (Place of publication: Publisher, date),
page number.
Albeit not required, sometimes it is useful to cite the inclusive pages, but if you do this and
then refer to a specific passage (page), you should add the following: “esp. 150” or “here 150.”
65

Nicholas Adontz, Armenia in the Period of Justinian: The Political Conditions Based on the
Naxarar System (Lisbon: Calouste Gulbenkian Press, 1970).
27

Rita Copeland, Rhetoric, Hermeneutics and Translation in the Middle Ages (Cambridge:
CUP, 1991), 34-36.
Note that a few well-known publishers, such as Cambridge University Press, can be cited in an
abbreviated form in footnotes, but not in the bibliography. Thus CUP, OUP.
If a publisher has offices in more than one city just use the first (most important office) in
citations.
CORRECT:
45
Bariša Krekić, ed., Urban Society of Eastern Europe in Premodern Times (Berkeley:
University of California Press, 1987).
WRONG:
45
Krekić, Bariša, ed., Urban Society of Eastern Europe in Premodern Times (Berkeley
and Los Angeles: University of California Press, 1987).
The reference units that comprise a footnote for a journal article are the following: Author’s
given name author’s family name, “Title of Article,” Title of Journal # (year): #-#.
33

[# in this example stands for volume number and inclusive page numbers that you will insert.
Note that a colon precedes the page numbers.]
117

Leo Ferrari, “Augustine’s Cosmography,” Augustinian Studies 27 (1996): 132-80.

The reference units that comprise a footnote for a chapter in a book by a single author are
the following:
Author’s given name author’s family name, “Title of Chapter,” Title of Book (Place of
publication: Publisher, year), #-#.
[# in this example stands for the inclusive page numbers that you will insert. Note that a comma
precedes the page numbers.]
David Talbot Rice, “The Origins of Byzantine Art,” in Byzantine Art, rev. and expanded
(Harmondsworth: Penguin Books, 1968), 41-64.
42

The reference units that comprise a footnote for a chapter in a book by a multiple authors (a
collected work) are the following:
Author’s given name author’s family name, “Title of Chapter,” Title of Book, ed. Editor’s given
name editor’s family name (Place of publication: Publisher, year), #-#.
[# in this example stands for the inclusive page numbers that you will insert.]
Aubrey Cannon, “Spatial Narratives of Death, Memory, and Transcendence,” in The
Space and Place of Death, ed. Helaine Silverman and David B. Small (Arlington, VA:
American Anthropological Association, 2002), 191-200.
45

The reference units that comprise a footnote for a journal article are the following:
Author’s given name author’s family name, “Title of Article,” Title of Journal # (year): #-#.
[# in this example stands for volume number and inclusive page numbers that you will insert.]
I. Hausherr, “Les grands courants de la spiritualité orientale,” Orientalia Christiana
Periodica 1 (1935): 130.
11

83

Leo Ferrari, “Augustine’s Cosmography,” Augustinian Studies 27 (1996): 132-80.

When the journal has issue numbers within certain volumes, the volume number will be
followed by a comma and ‘no. #’ before the year. The month or date of issue should not be
added to the year in any case.
J. Kyriakakis, “Byzantine Burial Customs: Care of the Deceased from Death to
Prothesis,” Greek Orthodox Theological Review 29, no. 2 (1984): 55.
27

34

3.6.2 Electronic sources
It is important to give as much information as possible, such as the author(s) of the site, the
institution that sponsors it, and the date the item was posted. Because addresses change, it is
also necessary to give the date you last accessed the material.

Websites
A citation to website content can often be limited to a mention in the text or in a note (“As of
July 19, 2008, the McDonald’s Corporation listed on its website . . .”). If a more formal
citation is desired, it may be styled as in the examples below. Because such content is subject
to change, include an access date or, if available, a date that the site was last modified.
If the website address is too long use the website's homepage (root page) or search page. If
that is not possible use an “no-width optional break” before each slash. You can't see the
inserted character(s), but Word reacts to one as if it were a space if necessary, without
breaking up the hyperlink.







Position the cursor where you want to insert the no-width break. It is recommended to
insert a character after each slash in the URL.
Click the Insert tab and click Symbol in the Symbols group. Select More Symbols to
launch the Symbol dialog box.
Click the Special Characters tab in the pop-up menu.
Scroll to the end of the list and highlight No-Width Optional Break.
Click Insert.
Repeat for each slash in URL.

Do NOT use services like tinyurl.com or bit.ly to shorten URLs.
“Google Privacy Policy,” last modified March 11, 2009,
http://www.google.com/intl/en/privacypolicy.html.
46
Department of Medieval Studies, Central European University, “Travel, Trade, and
Transportation: The Infrastructure of Spatial Mobility in Medieval East Central
Europe,” accessed July 19, 2015, https://medievalstudies.ceu.edu/projects/traveltrade-and-transportation-infrastructure-spatial-mobility-medieval-east-central.
47
“Google Privacy Policy.”
48
Department of Medieval Studies, CEU, “Travel, Trade, and Transportation.”
45

Books accessed electronically
Printed books accessed on Google Books or other online platforms need to be cited as a printed
book.
The following guidance is used only for electronically published books.

35

László Szilasi, “Mediocris Wathay avagy a szemérmes extractor: Funkcióváltás,
hierarchia-módosítás és eszközcsere; A Balassi-imitáció változatai Wathay Ferenc
költészetében” [Mediocris Wathay or the shy extractor: Changes of functions, hierarchy
and means; Variations of Balassi-imitations in the poetry of Ferenc Wathay], accessed
June 6, 2007, http://szelence.com/tan/szilasi_wathay.html.
35
Szilasi, “Mediocris Wathay.”
34

19

Gunther Barth, Bitter Strength: A History of the Chinese in the United States, 18501870 (Cambridge: Harvard University Press, 1964), NetLibrary e-book.
If the online edition of a printed book is important to be included, follow the format for
websites:
Philip B. Kurland and Ralph Lerner, ed., The Founders’ Constitution (Chicago:
University of Chicago Press, 1987), accessed June 27, 2006, http://presspubs.uchicago.edu/founders/.
48

Article in an online journal
Include a DOI (Digital Object Identifier) if the journal lists one. A DOI is a permanent ID
that, when appended to http://dx.doi.org/ in the address bar of an Internet browser, will lead
to the source. The http path does not appear in the citation, only the DOI number sequence.
Bernd Schneidmüller, “Fitting Medieval Europe into the World: Patterns of
Integration, Migration, and Uniqueness,” Transcultural Studies 2 (2014): 27,
accessed July 20, 2015, doi: 10.11588/ts.2014.2.17446.
77 Schneidmüller, “Fitting Medieval Europe into the World,” 29.
76

Gueorgi Kossinets and Duncan J. Watts, “Origins of Homophily in an Evolving
Social Network,” American Journal of Sociology 115 (2009): 411, accessed February
28, 2010, doi: 10.1086/599247.
24
Kossinets and Watts, “Origins of Homophily,” 439.
23

If no DOI is available, list a URL. It is advisable to use a Permanent URL (PURL), which is
static and reliable. Some databases call this a "Permalink."
Bernd Schneidmüller, “Fitting Medieval Europe into the World: Patterns of
Integration, Migration, and Uniqueness,” Transcultural Studies 2 (2014): 27,
accessed July 20, 2015, http://journals.ub.uni-heidelberg.de/index.php/transcultural
/article/view/17446.
76
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Blog entry or comment
Blog entries or comments may be cited in running text (“In a comment posted to The BeckerPosner Blog on February 23, 2010, . . .”) instead of in a note. The following examples show
the more formal versions of the citations. There is no need to add pseud. after an apparently
fictitious or informal name. Add the access date before the URL.
Jack, February 25, 2010 (7:03 p.m.), comment on Richard Posner, “Double Exports
in Five Years?,” The Becker-Posner Blog, February 21, 2010, accessed March 9 2010,
http://uchicagolaw.typepad.com/beckerposner/2010/02/double-exports-in-five-yearsposner.html.
13
Jack, comment on Posner, “Double Exports.”
12

Blog entries and comments are commonly omitted from a bibliography, unless they cite
essential data not found elsewhere or are subjects of analysis.

3.6.3 Reference books
Well-known reference books, such as common dictionaries and encyclopedias, are normally
cited in the footnotes (with edition specified and full publication facts omitted), but NOT in
the bibliography.
For shorter dictionary-type entries the abbreviation s.v. (sub verbo, meaning "under the
word") is used to specify the entry heading:
1

Merriam-Webster's Collegiate Dictionary, 11th edition, s.v. “Okra.”

For longer essay-type entries, esp. with known authors, create the footnote reference like a
chapter in a book:
Michael Borgolte, “Grablege,” in Lexikon des Mittelalters, ed. Bretscher-Gisiger,
Charlotte, Norbert Angermann, Robert-Henri Bautier, and Robert Auty, vol. 4, bk. 8
(Zurich/Munich: LexMA Verlag, 1898), 1628-30.
17
Borgolte, “Grablege,” 1629.
16

3.6.4 Classical works
If it matters which edition you use give full citation in the footnote and the bibliography.
Otherwise you can omit citation altogether as classical works are easy to look up by section.
Use Arabic numerals for chapter numbers, even if the publication uses Roman numerals.
Chapter, subchapter and section numbers should be separated by full stops without spaces.
You may abbreviate the author’s name and the title. For a list of accepted abbreviations,
consult the Oxford Classical Dictionary.
37

56
57

Stat. Silv. 1.3.32.
Ovid Met. 1.240, 242.

Aristotle
In 1831, the German scholar Immanuel Bekker published the most authoritative edition yet of
Aristotle’s surviving works in Greek. This edition was in two volumes with continuous
pagination (pp. 1-789 in volume 1 were continued by pp. 791-1462 in volume 2). On each
page, the Greek text was laid out in two columns. Between the columns line numbers were
printed: 5, 10, 15, etc. While it is acceptable to refer to Aristotle’s works by supplying Book
and Chapter numbers, the so-called Bekker numbers (that is reference to the text by the page
number, column “a” or “b”, and line number of the Bekker edition) is recommended for
precision’s sake. Because these numbers are printed in every modern Greek edition and in
different translations of Aristotle’s work, they enable precise reference to Aristotle, even for
someone using a different edition. Similar standard schemes of numeration exist for most
classical authors, consult your supervisor about the preferred system for your thesis.

3.6.5 Patrologiae and Other Frequently Used Series
If materials from these series appear repeatedly in your work, we recommend that you adopt a
scheme of abbreviation and place an explanatory note at the head of your bibliography. Thus:
PL [Patrologia Latina] indicates volumes in the series Patrologiae cursus completus, series
latina. Ed. J.-P. Migne. Paris: J.-P. Migne, 1844-. Facsimile reprint, Turnhout: Brepols,
1956-.
MGH [Monumenta Germaniae Historica] indicates volumes in the series Monumenta
Germaniae Historica. Various editors. Hannover: Hahn, 1831-. Accessed June 27,
2006. http://www.dmgh.de.
Alternatively you may clarify the abbreviations in a footnote in the first instance you refer to a
work from the series:
57

Augustinus, Opera Omnia, Patrologiae cursus completus, series latina 32-47, ed. J.P. Migne (Paris: J.-P. Migne, 1841-1857. Facsimile reprint, Turnhout: Brepols, 19821993), col. 322. [Hereafter: Patrologiae cursus completus, series latina = PL]
In the abbreviated form, you need make reference only to the author. title (in italics). PL or PG
number, column numbers or abbreviated MGH volume title and number. Thus:
34

Richard of St. Victor, Nonnullae allegoriae tabernaculi foederis, in PL 196, col. 196.
Einhard, Einhardi Vita Caroli Magni, ed. O. Holder-Egger, MGH SS rer. Germ. 25
(Hannover: Hahn, 1911), 344.
35
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However, if you have only a few citations from frequently cited series like this, then full
references need to be given:
34

Augustinus, Opera Omnia, Patrologiae cursus completus, series latina 32-47, ed. J.P. Migne (Paris: J.-P. Migne, 1841-1857; Facsimile reprint, Turnhout: Brepols, 19821993), col. 322.
37
Eusebius, Opera Omnia, Patrologiae cursus completus, series graeca 20-24, ed. J. P.
Migne (Paris: J.-P. Migne, 1857; Facsimile reprint, Athens: Centre for Patristic
Publications, 1997-1998), col. 211.
39
Einhard. Einhardi Vita Caroli Magni, ed. O. Holder-Egger, Monumenta Germaniae
Historica, Scriptores rerum Germanicarum in usum scholarum separatim editi 25
(Hannover: Hahn, 1911), 178.

3.6.6 Other sources
For information on citing government documents, reports, and legal cases, please see The
Chicago Manual 16th edition pp. 769-84 (sections 14.281-14.317), Turabian pp. 205-15
(sections 17.9-17.100).
For items retrieved from a commercial database, add the name of the database and an
accession number following the facts of publication. In this example, the dissertation cited
above is shown as it would be cited if it were retrieved from ProQuest’s database for
dissertations and theses.
Mihwa Choi, “Contesting Imaginaires in Death Rituals during the Northern Song
Dynasty,” PhD diss., University of Chicago, 2008, ProQuest (AAT 3300426).
16

An example of a painting from an electronic source:
Konrad von Friesach, “Anbetung der Könige,” REALonline image no. 001810,
Bildserver des IMAREAL, Institut für Realienkunde des Mittelalters und der frühen
Neuzeit, tethys.imareal.sbg.ac.at/realonline (last accessed December 3, 2006).
16

Make sure to delete hyperlinks to avoid blue underlined links in your footnote.
To do so, right click on link and select Remove Hyperlink in the drop-down menu.

3.6.7 Quoting from a work not consulted
In cases when you have no access to the original work you cite from, you will have to provide
data for both the original passage and the work citing it. This is how you can convey the fact
that you rely on the citation provided by another work and have not consulted the original.

39

This is prudent practice and will not disadvantage you, unless the original is a widely available
work which you should have checked. For example it is not elegant to provide second hand
citations for passages from the MGH, which is easily accessible online, (unless the fact that
another author cited it is relevant to your discussion).
R. Hill, “Christianity and Geography in Early Northumbria,” Studies in Church History 3
(1966): 127, cited in Clare Stancliffe, “Where was Oswald Killed?” in Oswald: Northumbrian
King to European Saint, ed. Clare Stancliffe and Eric Cambridge (Stamford: Paul Watkins,
1995), 91.
55
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4. Bibliography
The purpose of a bibliography is to identify the works you have consulted, to make clear that
you have indeed seen the works, and to enable your reader to find them. One of the hallmarks
of an accomplished scholar is his or her ability to prepare a bibliography consistent with an
assigned style, for a publication or, in this case, for a department.
For differences between formatting citations in footnotes and bibliographies see section
Differences between Footnotes and Bibliographies above.

4.1 Page Layout and Formatting
The purpose of a bibliography is to identify the works you have consulted, to make clear that
you have indeed seen the works, and to enable your reader to find them. One of the hallmarks
of an accomplished scholar is his or her ability to prepare a bibliography consistent with an
assigned style, for a publication or, in this case, for a department. The same is true of footnotes,
but these take a slightly different form than bibliographic citations; footnotes are discussed in
detail below. Please, keep in mind the difference in format!








Do not number the items on the bibliography. Arrange them alphabetically by author
or editor or title (the first item in the citation).
Do not group items in categories such as books, articles, etc. Integrate all the sources.
Divide the items into two groups with the headings ‘Primary Sources’ and ‘Secondary
Sources.’
Either use the thesis formatting template provided by the Computer and Statistics
Centre’s e-learning page or set it manually to single spaced with a 12pt space after
paragraphs (See Spacing, Alignment and Indentation above).
Use hanging indention (See Spacing, Alignment and Indentation above).
When citing more than one work by a single author, the author’s name appears only in
the first entry. Subsequent entries begin with three em-dashes. To insert an em-dash,
go to the Insert tab and click on ‘Symbol’ in the Symbols group. This will display all
the recently used symbols. To display the rest, click on ‘More Symbols’ at the bottom
of the drop-down box. Select the ‘Special Characters’ tab and click on ‘em-dash’. Click
the ‘Insert’ button three times, then close the window.

Goodich, Michael. Violence and Miracle in the Fourteenth Century. Chicago: University of
Chicago Press, 1995.
———. “Miracles and Disbelief in the Late Middle Ages.” Mediaevistik 1 (1988): 23-38.
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4.2 Elements of Bibliography Entries
This section enumerates the elements that make up bibliography entries and addresses the most
common questions regarding each.
Regarding certain questions of translation and transliteration of foreign titles and
names in footnotes and bibliography, the Department of Medieval Studies follows
guidelines somewhat different than the Chicago / Turabian style, so you will be
required to be able to make certain adjustments manually.
If your thesis contains significant amounts of non-English passages and references, it is
recommended to consult your supervisors and discuss if the nature of your thesis demands a
transliteration and translation practice other than specified in the general guidelines below.

4.2.1 Authors’ Names
Authors’ names are the first unit in a bibliography entry. Theses written at the Department of
Medieval Studies often contain unusual names and titles that the Chicago Manual may not
provide precise guidelines for. When in doubt make sure to consult the chapter below, discuss
with your supervisor or Professor Reed and decide on the format you will follow throughout
your thesis. It is absolutely critical that you refer to people, places and titles in a consistent
manner throughout your thesis, and provide explanatory notes where clarification is necessary.

Modern Names
The names of authors, family name followed by a comma and personal name, are the first unit
of the entry in bibliographies. They are followed by a period.
Heer, Friedrich.
Crummey, Robert O.
Klaniczay, Gábor. (Insert a comma even though the standard Hungarian convention is
Klaniczay Gábor)
As a basic rule, always follow the form of the name as printed on the title page of the work
cited. In the case where a work has been translated from one language into another and the
author’s name takes a different form, it is necessary to provide the form of the author’s name
given on the translation, followed by the original form in square brackets:
Ostrogorsky, George [Ostrogorski, Georgije]

42

Author’s Names in non-Latin Script: Transliteration


The author’s name is used in transliterated form in order to alphabetize it with the rest of
the bibliography, but the name is also given in the original script.

The department follows the recommendations of the Chicago Manual that “linguistic”
transliterations be used, that is, Latin letters with accents or other diacritical marks (some
examples are: Č, Đ, and Ž) for any thesis containing texts. This is especially important where
the research concerns the text itself in the form of linguistic or textual analysis.
For purely historical or art historical theses, however, it is more convenient to use the system
of the U.S. Board on Geographic Names. Use only one transliteration scheme throughout the
thesis; DO NOT mix the systems. The formats for each type of source are the same even if
transliteration is necessary.
It is not obligatory to follow one scheme in particular, only to be consistent in your application
of the chosen scheme. However, in bibliographies and footnote citations, where an author has
used a transliteration scheme different from the one used in your bibliography, use the author’s
form:
Romančuk, Anna I. and not Romanchuk, Anna I. (from Cyrillic Романчук)
Zubar, Vitaliy M. and not Zubar’, Vitaliy M. (from Cyrillic Зубарь)
Note that although it is not necessary to transliterate Greek titles, it IS necessary to transliterate
and/or Anglicize the names of Greek authors.
Dionysios Zagoraios
John Climacus, Saint
[Theodoret, bishop of Cyrrhus] Θεοδωρήτου ἐπισκόπου πόλεως Κύρρου.

Medieval Authors’ Names
The Chicago Manual of Style notes that there are many ways to cite names. The main thing is
to choose one style and use it consistently. In order to achieve consistency adherence to the
following principles is suggested.

Titles
An author’s title is part of his name:
Nikephorus the Patriarch.
Where a saint’s title appears as part of his name on the title page of the work, this should be
shown in the bibliographic citation. Where a saint’s title does not appear on the title page, do
43

not use it in the bibliography:
Francis of Assisi, Saint.
Becket, Thomas.

Geographic appellations
In general, medieval authors are cited by first name only, e.g., Augustine. Some well-known
medieval authors also have geographic appellations, but these are NOT surnames. The wellknown example of Thomas Aquinas should be cited as:
Thomas Aquinas.
However, in primary sources his name might appear as Thomas de Aquino and can be cited as
such. The name Peter Abelard (being the English style of Pierre Abailard), another common
example, appears in Patrologia Latina and other collections as Petrus Abelardus and, again,
can be cited as such.
The basic rule, once again, is to follow the form of the name that appears on the title page
of the work cited. Thus, Thomas Aquinas, Saint, is a possibility!
If there are more works cited by the same author and each appears in different variants in the
publications used, either use the form you use to refer to the author in your text or most select
the most important (most recent) work in the list and use that in the first instance. Subsequent
entries by the same author will be represented by an em-dash. In both cases the variant that
appears on the title page of the publication cited should be placed in a square bracket following
the author’s name or the em-dash.

Place names as surnames
When a place name is part of the author’s name, it is not used as a surname:
Nicolaus de Dresda, if taken from a primary source that uses this form, but NOT de
Dresda, Nicolaus.
In secondary sources the Anglicized forms of names should be used:
Nicholas of Dresden.
Hildegard of Bingen, NOT Hildegard von Bingen.
In certain cases, a particular convention may apply in the English form of a saint’s name. Thus,
in Hungarian, St. Margaret is known as Árpádházi Szent Margit, but in English always as St.
Margaret of Hungary. This convention will need to be followed when translating a title from
Hungarian into English.
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Difficult Names
In author’s names with particles, the particle can be part of the surname or a so-called nobiliary
particle.
The general rule of thumb is that if the particle is capitalized (check the spelling on the title
page of the book) it is part of the surname and therefore you alphabetize according to the
particle. If the particle is lowercase, it will follow the first name separated by a comma in
alphabetized lists.
Van Buren, Martin
but
Hardt, Hermann, von der
When there is a significant number of names with particles, check the practice of the country
of origin, which may differ significantly.








In the Netherlands, names starting with ‘van’ are alphabetised under the initial letter of the
following name proper, so van der Waals appears under ‘W’, The ‘v’ in the nobiliary
particle is in lower case, except when the surname is used as standalone (when the first
name or initials are omitted), in which case it is capitalised, as in “the painter Van Gogh.”
In France, the particle de or d’ precedes a nom de terre, dropping it or not when referring
to the surname (dropped from Tocqueville but not from de Gaulle) in text or bibliography
is a matter of tradition. If you are unable from any source to determine what that tradition
might be, err on the side of retaining the particle.
In Germany, Belgium and the United States any surnames beginning with “Van” appear
under ‘V’. So for example Anna-Dorothee von den Brincken, Eric Van Rompuy and Dick
Van Dyke are listed under ‘V’, not under ‘B,’ ‘R’ or ‘D’, regardless whether their names
are spelled lower- or uppercase.
In Arabic personal names, the article is ignored and the name is alphabetized under the
captial letter of the last name: Aziz al-Azmeh is alphabetized under Azmeh.

No author
If no author is given on the title page, use the title as the main entry in the citation.
Biblia sacra iuxta Vulgatam versionem. Stuttgart, 1883.
Additional information about editors or compilers can sometimes be culled from the verso of
a title page and even from a preface. If information is ascertained from outside the work itself,
this information should appear in square brackets.
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4.2.2 Titles
Titles are the next unit of the citation, set off by periods. Titles of books and journals are
italicized.
Fennell, John. The Crisis of Medieval Russia 1200-1304. London: Longman, 1983.
A title within a book title IS italicized, but appears within quotation marks:
Smith, Alan. A Critical Translation of Augustine’s “City of God.” Oxford: Oxford
University Press, 1995.
In an article in a journal or collected work, a title within a title is italicized:
Blumenthal, H. J. “Neoplatonic Elements in the De anima Commentaries.” Phronesis
21 (1976): 64-87.
Note that words in languages other than the main language of the title are NOT italicized:
Bonner, Gerald. Saints, Sanctity and Virtus in the Early Middle Ages. London: John
Murray, 1972.
Separate subtitles with colon even if original language uses different punctuation. Use
semicolon for second subtitle.
Szilasi, László. “Mediocris Wathay avagy a szemérmes extractor: Funkcióváltás, hierarchiamódosítás és eszközcsere; a Balassi-imitáció változatai Wathay Ferenc költészetében”
(Medioris Wathay or the shy extractor: Changes of functions, hierarchy and means;
Variations of Balassi-imitations in the poetry of Ferenc Wathay). Online critical
edition: http://irodalom.web.elte.hu/tan/szilasi_wathay (Accessed 6 June, 2014).

Translation of titles
According to the guidelines of the Department of Medieval Studies, if a language is written in
a non-Latin script, the title of the work is not transliterated, although it is translated into
English.
It is not necessary to translate book and article titles in Latin, Greek, French, Italian,
Spanish or German.
The translation is given in sentence style in square brackets, following the original title. The
square brackets around the translation show that it was added by you and was not on the title
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page. The translation is written in sentence style (not capitalized except for proper nouns like
place-names) and is NOT italicized.
Note that the period at the end of the title bibliographic unit follows the translation (outside the
square bracket), not the original title. There is no punctuation between the original title and the
translated title in square brackets.

Budak, Neven. “I fiorentini nella Slavonia e nella Croazia.” Archivio Storico Italiano
153, no. 4 (1995): 681-95.
[Tvorogov, O.V.] Творогов, О.В. “Палея Толковая” [Paleja Tolkovaja]. In Словарь
книжников и книжности древней Руси. Vol 1, XI - первая половина XIV в.
[Dictionary of the Writers and Literature of Ancient Rus’. Vol. 1, From the
eleventh to the first half of the fourteenth century], 286. Leningrad: Наука,
1987.
The titles of journals and series do not have to be translated.
It is necessary only to translate the title of an article, not the title of a journal.
Kelar, P. “Początki zakonu dominikańskiego w Połsce” [The beginnings of the
Dominican Order in Poland]. Nasza Przeszłość 39 (1979): 132-45.
Sedlák, Jan. “Počátkové kalicha v Čechách” [The origins of the lay chalice in the Czech
lands]. Časopis katolického duchovenstva 52 (1911): 398-401.
Parts of the title in Latin, Greek, French, Italian, Spanish or German do not need to be translated
or repeated in the translation of the title supplied in square brackets:
Katičić, Radoslav. “Aedificaverunt Ragusium et habitaverunt in eo: tragom najstarijih
dubrovačkih zapisa” [Tracing the oldest texts of Dubrovnik]. Starohrvatska
prosvjeta 18 (1988): 5-38.
Note that the term in the title (veka, century, siècle, etc.) and century terms must be spelled out
in full in the translation of titles.
[Tvorogov, O.V.] Творогов, О.В. “Палея Толковая” [Paleja Tolkovaja]. In Словарь
книжников и книжности древней Руси. Vol 1, XI - первая половина XIV в.
[Dictionary of the Writers and Literature of Ancient Rus’. Vol. 1, From the
eleventh to the first half of the fourteenth century], 286. Leningrad: Наука,
1987.
Note that square brackets are used inside parentheses (and vice versa), not double parentheses,
to deal with complicated punctuation.
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Ancient Greek

Ancient Greek titles do not need to be transliterated or translated. Supply translation of modern
Greek titles in square brackets if necessary. Consult your supervisor about their preference in
detail.
Hinterberger, Martin. “Ο Ανδρέας Λιβαδηνός, συγγραφέας/γραφέας λόγιων κειμένων,
αναγνώστης/γραφέας δημώδων κειμένων· ο ελληνικός κώδικας 525 του
Μόναχου.” In Κωδικογράφοι, συλλέκτες, διασκευαστές και εκδότες· χειρόγραφα
και εκδόσεις της όψιμης βυζαντινής καὶ πρώϊμης νεοελληνικής λογοτεχνίας
[Copyists, collectors, redactors and editors: Manuscripts and editions of late
Byzantine and early modern Greek literature], ed. David Holton, Tina Lendari,
Ulrich Moennig and Peter Vejleskov, 25-42. Hērakleio: Panepistēmiakes
ekdoseis Krētēs, 2005.
Hinterberger, Martin. “Ἡ ἐπέτεια τῆς καταστροφῆς. Ὁ Λόγος ἱστρορικὸς τοῦ Φιλοθέου
Κόκκινου γιὰ τὴν ἅλωση τῆς Ἡρακλείας τοῦ 1351.” In L’Écriture de la
mémoire: La littérarité de l’historiographie; Actes de iiie colloque international
philologique; Nicosie, 6–7–8 mai 2004, Dossiers byzantins, 6: 331-51. Paris:
Boccard, 2006.
[Kaltsogiannē, Εlenē], Καλτσογιάννη, Ελένη, Σοφία Κοτζάμπαση [Sofia Kotzampasē]
and Ἠλιάνα Παρασκρευοπούλου [Ēliana Paraskeuopoulou]. Η Θεσσαλονίκη
στη βυζαντινή λογοτεχνία : Ρητορικά και αγιολογικά κείμενα, Βυζαντινὰ
Κείμενα καὶ Μελέται, 32. Thessalonikē: Kentron Byzantinōn Ereunōn, 2000.

Modern Greek critical editions
[Theodoret, bishop of Cyrrhus] Θεοδωρήτου ἐπισκόπου πόλεως Κύρρου. Πρὸς τὰς
ἐπενεχθεῖσας αὐτῷ ἐπερωτήσεις παρὰ τῶν ἐξ Αἰγύπτου ἐπισκόπων
ἀποκρίσεις. Ed. A. Papadopoulos-Kerameus. St. Petersburg: B. Kirschbaum,
1895. Reprint, Leipzig: Zentralantikariat der DDR, 1975.
Historia monachorum in Aegypto: Ἡ κατ΄ Αἴγυπτον τῶν μοναχῶν ἱστορία. Critical
edition of the Greek text with an annotated translation by André-Jean
Festugière. Brussels: Société des Bollandistes, 1961.
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Modern Greek

Modern Greek uses two major different systems of accentuation; when listing bibliographic
items in Modern Greek, the accentuation style of the original should be preserved as given on
the title page.
Book by one author:
Koukoulēs, Phaidon [Φαίδων Κουκούλης]. Βυζαντινῶν βίος καὶ πολιτισμός. Vol. 6.
Collection de l'Institut Français d'Athènes 90. Athens: n. p., 1955.
Article by an author in a volume edited by another author:
Pitsakēs, Kōnstantinos G. [Κωνστάντινος Γ. Πιτσάκης]. “Η θέση των ομοφυλοφίλων
στη Βυζαντινή κοινωνία” [The position of homosexuals in the Byzantine
society]. In Πρακτικά ημερίδας Οι περιθωριακοί στο Βυζάντιο 9 Μαίου 1992,
ed. Chrysa A. Maltezou, 169-269. Athens: Hidryma Goulandrē-Chorn, 1993.

Capitalization (Headline Style)
In English-language titles, all relevant words signifying the content are to be capitalized, but
not articles (the, a, an), prepositions (in, on, for), or conjunctions (and, but, until).
England and the Continent in the Eighth Century
This rule does not apply to titles in other languages. For Latin and modern “Western” languages
(French, Norwegian, German, etc.), follow their respective rules of orthography and
capitalization.


French titles

Capitalization of titles in French can be problematic. The Chicago Manual of Style recommends
capitalizing the first word of the title and any proper nouns in it.
If your bibliography contains a significant number of French works, you should adopt the
following, more detailed, guidelines: Always capitalize the first word and any proper nouns in
the title; if the first word is an article, capitalize the substantive and any intervening
adjective(s); if the first word is neither an article nor an adjective, put all the following words
in lower case.
Costa-Louillet, G. “Saints de Sicile et d’Italie méridionale aux VIIIe, IXe et Xe siècles.”
Byzantion 29-30 (1959-1960): 89-173.
Use standard English-style quotation marks for French articles (“ ” instead of << >>) because
you are writing in English and using English punctuation conventions.
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Volume numbers
Use Arabic numerals for volume numbers, even if the publication uses Roman numerals.
von Freiherrn, Ludwig. Geschichte der Papste seit dem Ausgang des Mittelalters. Vol. 9,
Geschichte der Papste im Zeitalter der katholischen Reformation und Restauration:
Gregor XIII (1572-1585). Freiburg im Breisgau: Herder, 1923.
Not:
von Freiherrn, Ludwig. Geschichte der Papste seit dem Ausgang des Mittelalters: Band IX,
Geschichte der Papste im Zeitalter der katholischen Reformation und Restauration.
Gregor XIII (1572-1585). Freiburg im Breisgau: Herder, 1923.

Single volume of a multivolume book may be published in two or more physical books. The
reference in this case must include the book as well as the volume number.
Lach, Donald. Asia in the Making of Europe. Vol. 2, bk. 3, The Scholarly Disciplines. Chicago:
Chicago University Press, 1977.
Harley, J. B., and David Woodward, eds. The History of Cartography. Vol. 2, bk, 1,
Cartography in the Traditional East and Southeast Asian Societies. Chicago:
University of Chicago Press, 1994.
or
Harley, J. B., and David Woodward, eds. Cartography in the Traditional East and Southeast
Asian Societies. Vol. 2, bk, 2, of The History of Cartography. Chicago: University of
Chicago Press, 1994.

4.2.3 Editors, Translators, and Compilers
The unit of editor, translator, and/or compiler follows the title and is set off by periods. The
accepted short forms for abbreviating these terms are: ed., tr., and comp. Even if there are
more than one editor, translator, or compiler, use ed., tr., and comp. because these terms stand
for “edited by”, “translated by” and “compiled by,” and therefore do not show a plural form.
Annotators should be considered editors. Editors, translators, and/or compilers may be cited
in place of an author.
Turner, Victor, ed. Celebration: Studies in Festivity and Ritual. Washington, D.C.,
Smithsonian Institution Press, 1982.
Heer, Friedrich. The Holy Roman Empire. Tr. Janet Sondheimer. London: Phoenix
Giant, 1968.
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List all of the editors in the bibliography, although you can use and others (or et al.) in the
footnotes. List the editors in the order they appear on the title page of the publication.
Redman, Charles L., Mary Jane Berman, Edward V. Curtin, Tom Langhorne, Jr., Nina
M. Versaggi, Jeffrey Wanser, ed. Social Archaeology: Beyond Subsistence and
Dating. Studies in Archeology. New York: Academic Press, 1978.
Sometimes, the editor’s or translator’s role will be explained by the title, and the editor himself
can be cited as the author:
Chichurov, Igor S [Чичуров, И. С]. Византийские исторические сочинения:
“Хронография” Феофана, “Бревиарий” Никифора; Тексты, перевод,
комментарий [Byzantine historical works: Theophanus’ “Chronography,”
Nikephorus’ “Breviarium;” Texts, translation, commentary]. Moscow: Nauka,
1980.
Note that in this example the editor is neither the translator nor the author of the commentary:
Philopon, Johannes. Commentaire sur le “De anima” d’Aristotle: Traduction de
Guillaume de Moerbecke. Corpus Latinum Commentariorum in Aristotelem
Graecorum 3. Ed. G. Verbeke. Leuven: Leuven University Press, 1965.
If there is no author, editor, or compiler use the title of the work as the start of the citation.

4.2.4 Series Titles
Series are a popular way for institutions or research units to publish works. A series often has
its own title and volumes in a series may or may not have volume numbers. If the volume
numbers are given in Roman numerals on the work, use Arabic numbers in footnotes and the
bibliography. The title of the volume is italicized, but NOT the series title. The publisher’s
series is a bibliographic unit that precedes the publication data. The series editor unit, if there
is one, follows the series title (and precedes the volume number), but needs to be supplied only
if the person of the series editor is relevant to your work for some reason.
Mango, Cyril. The Art of the Byzantine Empire, 312-1483: Sources and Documents.
Sources and Documents in the History of Art, ed. H. W. Johnson. Englewood
Cliffs, NJ: Prentice-Hall, 1972.
Lecouteux, Claude. Les Monstres dans la pensée mediévale européenne. Cultures et
civilisations mediévales, no. 10. Paris: Presses de l’Université de ParisSorbonne, 1995.
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Patrologiae and Other Frequently Used Series
If materials from these series appear repeatedly in your bibliography, we recommend that you
adopt a scheme of abbreviation and place an explanatory note at the head of your bibliography.
Thus:
PL [Patrologia Latina] indicates volumes in the series Patrologiae cursus completus, series
latina. Ed. J.-P. Migne. Paris: J.-P. Migne, 1844-. Facsimile reprint, Turnhout: Brepols,
1956-.
MGH [Monumenta Germaniae Historica] indicates volumes in the series Monumenta
Germaniae Historica. Various editors. Hannover: Hahn, 1831-. Accessed June 27,
2006. http://www.dmgh.de.
In the abbreviated form, you need make reference only to the author. title (in italics). PL or PG
number, coll. numbers or abbreviated MGH volume title and number. Thus:
Richard of St. Victor. Nonnullae allegoriae tabernaculi foederis. In PL 196 coll. 193201.
Einhard. Einhardi Vita Caroli Magni. Edited by O. Holder-Egger, MGH SS rer. Germ.
25. Hannover: Hahn, 1911.
However, if you have only a few citations from frequently cited series like this, then full
references need to be given:
Augustinus. Opera Omnia. Patrologiae cursus completus, series latina 32-47. Ed. J.P. Migne. Paris: J.-P. Migne, 1841-1857. Facsimile reprint, Turnhout: Brepols,
1982-1993.
Eusebius. Opera omnia. Patrologiae cursus completus, series graeca 20-24. Ed. J. P.
Migne, Paris: J.-P. Migne, 1857. Facsimile reprint, Athens: Centre for Patristic
Publications, 1997-1998.
Einhard. Einhardi Vita Caroli Magni, ed. O. Holder-Egger, Monumenta Germaniae
Historica, Scriptores rerum Germanicarum in usum scholarum separatim editi
25. Hannover: Hahn, 1911.

4.2.5 Date of Publication
The date of publication is the final unit of an entry.
The date cited should be the date of publication of the book you use. This might not be the date
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of first publication. However, in the case of revised editions or new editions, the date of first
publication and the date of publication of the new edition will need to be cited.
Where the date of publication is not stated in the book and cannot be determined, use: n.d. If
the date, or approximate date, of publication can be determined from the book’s contents or
material, do not use n.d. but place the appropriate date in square brackets -- [1966] or [ca.1966].

Missing Publication Details
When a piece of information is missing from an entry, it may sometimes be supplied or clarified
by a comment in square brackets [ ]. If an unexplained abbreviation or a mistake appears, it is
possible to insert [sic] after it to show that this was in the original. This should be done
judiciously so as not to introduce false information into an entry. For instance, in the
trransliterated Syriac example below the place of publication is given on the work only as
Holland, but the monastery that issued the work is known to be in Glane. In this example there
is no author so the title is used as the first unit of the entry.
Makhtvonūthô dhtashcīthô dhzavnô dh’ūlsonô dahwô v’ūrhoy wv’omīdh wavkuloh bēth
nahrīn dsīmô l’nosh ’ūrhoyô malphonô dhmadhrashtô dh’ūrhoy bashnath 515 m.
[Glane]: Monastery of St. Ephrem the Syrian, 1984.

4.2.6 Place of Publication
The place of publication is followed by a colon and then the name of the publisher, followed
by a comma and then the year of publication.
As a general rule the place name that appears on the title page or in the publication details must
be cited in its English form (thus Vienna, not Vindibonae or Wien).
However, in some cases, for example, Bratislava, it is possible that an entirely different form
of the name will appear in the book to be cited, such as the German Pressburg or the Hungarian
Pozsony. In cases where this information is of historical significance, you should cite the name
that appears in the book followed by its modern English equivalent in square brackets, thus:
Pressburg [Bratislava], 1780.
The place of publication should always be in the English form, if such exists. Here are some
examples:
Barcelona, Belgrade, Berlin, Boulogne, Bratislava, Brno, Brussels, Bucharest, Cologne,
Cracow, Edinburgh, Florence, Genoa, Kiev, Leipzig, London, Lviv, Mantua (NOT Mantova),
Milan, Moscow, Muenster, Munich, Naples, Paris, Padua, Prague, Rome, St. Petersburg, Sofia,
Split, Strasbourg, Trogir (NOT Trau), Turin, Venice, Vienna (NOT Wien), Vilnius, Warsaw,
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Yerevan.
For Petrograd (1914-1924), Leningrad (1924-1991) and St. Petersburg (1991-): use the place
name that appears on the title page, but note that “Saint-Petersburg” is not in current use. You
may put [St. Petersburg] in square brackets after the former name.
To avoid confusion with UK place names, for small places of publication in the United States,
use the postal abbreviation for the state when there is liable to be confusion: Berkeley, CA;
Ithaca, NY; Berlin, NY; note that there are no periods in these abbreviations. Washington, D.C.
is an exception (to distinguish it from Washington State).

List of US postal codes:
Alabama AL
Alaska AK
Arizona AZ
Arkansas AR
California CA
Colorado CO
Connecticut CT
Delaware DE
District of Columbia DC
Florida FL
Georgia GA
Hawaii HI
Idaho ID
Illinois IL
Iowa IA
Kansas KS

Kentucky KY
Louisiana LA
Maine ME
Maryland MD
Massachusetts MA
Michigan MI
Minnesota MN
Mississippi MS
Missouri MO
Montana MT
Nebraska NE
Nevada NV
New Hampshire NH
New Jersey NJ
New Mexico NM
New York NY
North Carolina NC
North Dakota ND

Ohio OH
Oklahoma OK
Oregon OR
Pennsylvania PA
Rhode Island RI
South Carolina SC
South Dakota SD
Tennessee TN
Texas TX
Utah UT
Vermont VT
Virginia VA
Washington WA
West Virginia WV
Wisconsin WI
Wyoming WY

Examples:
Redman, Charles. Qsar es-Seghir: An Archaeological View of Medieval Life. Orlando,
FL: Academic Press, 1986.
Canicelli, Thomas A., ed. King Alfred’s Version of St. Augustine’s “Soliloquies.”
Cambridge: Harvard University Press, 1969.
There is no need to specify MA (for Massachusetts) because there is no other Harvard. In the
United Kingdom, do not specify the country: Oxford, NOT Oxford, UK. However, use Oxford,
MI if it is published in Mississippi.
Clemoes, Peter. Interactions of Thought and Language in Old English Poetry.
Cambridge: Cambridge University Press, 1995.
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In general, small presses are likely to operate from small towns, and in such cases the state,
county, provincia, département, etc. will be relevant. When a well-known publisher operates
in a small town (such as Penguin in Harmondsworth or Sutton Publishing in Stroud), the county
is not required – the place of publication is taken as known due to the importance of the
publisher.
If a publisher lists several places of publication use the first one only as that is the main office.
However, if there are two publishers (a museum and an institute or something of the sort), give
both names and both places, divided by a semicolon.

4.2.7 Publisher
The publisher is usually listed on the title page or on its verso. If an institute, museum,
historical society, or other group is issuing a work, they should be given as the publisher if
there is no separate publisher.
The printing house that did the printing should not be used as a publisher unless they performed
both functions, printing and issuing (publishing). It is not necessary to include business
abbreviations in the publisher’s name, such as Inc., Ltd, S.p.A., and so on.
Barker, Philip. Techniques of Archaeological Excavation. London: Batsford, 1977.
NOT
Barker, Philip. Techniques of Archaeological Excavation. Tiptree, Essex: The Anchor
Press Ltd., 1977.
However, there are occasions when a particular press will publish on behalf of another
institution or publisher:
Thomas, Charles. The Early Christian Archaeology of North Britain: The Hunter
Marshall Lectures delivered at the University of Glasgow in January and
February 1968. London: Oxford University Press for the University of
Glasgow, 1971.

No Publisher
If there is no publisher on the work omit reference to it. You should, however, make every
effort to discover the publisher as many footnotes in older styles omit this information. Since
the bibliography is a finding list including the publisher gives a reader another clue to look for
it. Including the publisher also shows that you had the book in your hand or went to the trouble
to look up the publisher in a catalogue.
Short of finding the physical volume, one of the most reliable ways of looking up missing
29

publication data is checking the title and the correct edition at www.worldcat.org or similar
aggregate library catalogues online.
If you cannot ascertain the place of publication simply omit it. It is not necessary to use n.p.
for No Place.
Shchapov, Afanasiy P. [Щапов Афанасий Прокофьевич]. Русский раскол
старообрядчества [Russian Old Believer dissent]. Kazan’, 1859.

Multiple publishers
If a publisher lists several places of publication use the first one only as that is the main office.
However, if there are two publishers (a museum and an institute or something of the sort), give
both names and both places, divided by a semicolon.

Publication Data in non-Latin Script
The name of the place of publication should be in English, especially if there are many variants.
The publisher can be given in the original alphabet or transliterated, just be consistent.
[Iljovski, Risto] Илјовски, Ристо. Кој и кога владеел со македонија [Who ruled Macedonia
and how long?]. Skopje: Ina Komers, 2003.

4.3 Different types of sources in bibliographies
4.3.1 Component Parts in Collected Works and Edited Books
Collected works refer to various types of works such as a collection of essays by different
people edited by another person; a collection of essays by a single author, but edited by
someone else; a festschrift; or a collection of articles reprinted from a journal.
The information about the title of the whole book, the editor and the pages of the essay is a unit
inserted between the title of the essay and place of publication, in the following sequence:
author. “Title.” In Title, ed. [name], pages.
Note that in a citation for a collected work the pages of the item follow the editors’ names and
are part of the same bibliographic unit.
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Bak, János M. “Queens as Scapegoats in Medieval Hungary.” In Queens and Queenship
in Medieval Europe, ed. Anne Duggan, 223-33. Woodbridge, UK: The Boydell
Press, 1997.
Hall, D. “The Middle Ages.” In The Perthshire Book, ed. Donald Omand, 59-73.
Edinburgh: Birlinn, 1999.
Kurelac, Miroslav. “Narrative sources.” In Croatia in the Early Middle Ages: A
Cultural Survey, ed. Ivan Supičić, 117-46. London: Philip Wilson Publishers,
1999.
Kuznetsova, Anna. “St. Stephen of Perm: Missionary and Popular Saint.” In The Man
of Many Devices, Who Wandered Full Many Ways: Festschrift in Honor of
János M. Bak, ed. Balázs Nagy and Marcell Sebők, 222-29. Budapest: Central
European University Press, 1999.
If you cite more than four essays or component parts of the same edited volume, you may in
certain cases abbreviate the volume’s bibliographic details in the entries for the component
parts and add the full citation as a separate volume under the editor(s)’ names. However, please
note that this is an unorthodox way of cutting down bibliography length. Please make sure you
consult your supervisor if this is an advisable practice for you.
Birnbaum, Marianna. “The Mantle of Béla IV.” In Nagy and Sebők (eds), The Man of
Many Devices, 499-502.
Bíró, András. “Baksi.” In Nagy and Sebők (eds), The Man of Many Devices, 3-6.
Kuznetsova, Anna. “St. Stephen of Perm: Missionary and Popular Saint.” In Nagy
and Sebők (eds), The Man of Many Devices, 222-29.
Nagy, Balázs and Marcell Sebők (eds). The Man of Many Devices, Who Wandered Full
Many Ways: Festschrift in Honor of János M. Bak. Budapest: Central European
University Press, 1999.

4.3.2 Journal Articles
The format for citing journal articles differs from that for books. The title of the journal is
italicized (but not translated), not the title of the article; the title of the article appears within
quotation marks. The volume number follows the title, with no “Vol.” In is not used for
journals, only for collected (edited works).
Ward-Perkins, Bryan. “Why did the Anglo-Saxons not become more British?” The
English Historical Review 115 (2000): 513-533.
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Kelar, P. “Początki zakonu dominikańskiego w Połsce” [The beginnings of the
Dominican Order in Poland]. Nasza Przeszłość 39 (1979): 132-145.
Tyler, Elizabeth M. “‘The Eyes of the Beholders were Dazzled’: Treasure and Artifice
in Encomium Emmae Reginae.” Early Medieval Europe 8 (1999): 247-270.
It is important to give both the volume and issue number in order to help a reader locate the
article, especially if the journal is paginated from 1 in every issue. It is not necessary to give
the date (month) of publication. Note the punctuation scheme at the end of a citation, where
the year of issue appears in parentheses, followed by a colon, followed by the inclusive page
numbers and a period. Do NOT follow this format for collected works (edited books); there
the page numbers are embedded in the body of the entry. In the case of non-Latin alphabets do
not transliterate the journal title.
[Istrin, V.M.] Истрин, В.М. “Толковая Палея и Хроника Георгия Амартола” [The
Tolkova Paleja and the Hronika of George Amartola]. Известия Отделения
русского языка и словесности Академии наук 29 (1925): 369-379.
Horn, Maurycy. “Jewish Jurisdictions’ Dependence on Royal Power in Poland and
Lithuania up to 1548.” Acta Poloniae Historica 76 (1997): 5-17.
(This publication has no annual volume number: there is a no. 75 for 1997, too. The
pagination starts at 1 in each issue.)
Juinhut, Jean-Pierre. “The Man Who Loved Too Much: The Legend of Leyli and
Majnun.” Azerbaijan International 6, no. 3 (1998): 33-38.
(This journal paginates from 1 in each issue, thus it is necessary to give the issue number.)

4.3.3 Unpublished Sources
Dissertations and Theses
The full structure is as follows:
author’s surname, first name. title within quotation marks and NOT in italics. Type of work
(e.g., Ph.D. diss.). place, university or institution name, year.
Mishin, Dmitrij Jevgenjevič. “Şaqlabī Servants in Islamic Spain and North Africa in
the Early Middle Ages.” Ph.D. dissertation. Budapest: Central European
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University, 1999.
Thacker, A.T. “The Social and Continental Background to Early Anglo-Saxon
Hagiography.” D. Phil. thesis. Oxford: University of Oxford, 1976.

Duplicated material
For Xerox copies and the like, we follow The Chicago Manual of Style:
de Alarcón, Salvador Florencio. “Comprendio de las noticias correspondientes a el
real y minas de San Francisco de Aziz de Río Chico... de 20 octubre [1777].”
Department of Geography, University of California, Berkeley. Photocopy.

Paper Read at a Conference
Zerubavel, Eviatar. “The Benedictine Ethic and the Spirit of Scheduling.” Paper
presented at the annual meeting of the International Society for the Comparative
Study of Civilizations, Milwaukee, April 1978.
McLaughlin, David. “Acid Rain: The Cleaning and Conservation of Stonework in
Bath.” Paper presented at the ICOMOS UK Seminar on Managing World
Heritage Sites in Britain, University of York, November 1991.

Manuscripts
If several manuscripts are cited, it is justifiable to group them together in a separate section
before listing primary and secondary sources in the bibliography.
For manuscripts and archival material, the basic rule of citation is that the material consulted
must be retrievable by the reader. For a manuscript, the full entry should be constructed as
follows:
name of author (if known). title of manuscript, or name by which it is known, in italics.
name of library, museum, etc. (translate the names of institutions that are in languages other
than English, Latin, Greek, French, Italian, Spanish or German) followed by the
institution’s reference number, shelfmark, etc. language. date (not essential, if known only).
place or origin (if known).
Guilelmus de Monte Lauduno. Sacramentale. Pražská Univerzitní Knihovna [Prague
University Library] MS V B 17, fols. 224ra-297ra.
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Give as much information as possible. It may not be possible to cite an “author”, but in this
case the title and/or place of deposit should form the first unit of the citation.
The press mark (or call number) often consists of an internationally accepted abbreviation for
the manuscript collection, accompanied by a number in that collection: e.g., Clm = Codex
latinus monacensis = a manuscript (MS) in the Bayerische Staatsbibliothek (Bavarian State
Library) at Munich.
For a guide to the Latin names for MS collections, see F. W. Hall, A Companion to Classical
Texts (Oxford: The Clarendon Press, 1913).
The date and other data that concerns the description of the manuscript as an object is optional
and can be given as year or century. If century, then in Roman numerals and s. for saeculum
(to which the specification “early” [in for ineunte] or “late” [ex for exeunte] may be added, e.g.
s.xii ex.), or a more general date, such as s.xii/xiii.
John Mercer. Fleming’s Chronicle (The Chronicle of Perth). National Library of
Scotland Adv. 35.4.4. Scots. s.xvi/xvii. Perth.

Archival material
Give the location of the archive and the character of the document or material in English,
followed by the reference, signature etc. for that archive.
Wojewodzkie Archivum Panstwowe Gdańsk [Archives of the Voivodship of Gdańsk].
Dyplomy i korespondencja [Charters and correspondence]. Correspondence with
Lithuanian towns. 300D/8.
Abbreviations need to be explained. Concerning material in the Hungarian National Archives,
for example, the abbreviation ‘DL’ should be explained as a charter in the so-called diplomatic
archives Collectio Antemohacsiana.

4.3.4 Electronic sources
It is important to give as much information as possible, such as the author(s) of the site, the
institution that sponsors it, and the date the item was posted. Because addresses change, it is
also necessary to give the date you last accessed the material.
Make sure to delete hyperlinks to avoid blue underlined links in your bibliography.
To do so, right click on link and select Remove Hyperlink in the drop-down menu.
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Websites
A citation to website content can often be limited to a mention in the text or in a note (“As of
July 19, 2008, the Department of Medieval Studies listed on its website . . .”). If a more
formal citation is desired, it may be styled as in the examples below. Because such content is
subject to change, include an access date or, if available, a date that the site was last
modified.
Google.
“Google
Privacy
Policy.”
Last
modified
http://www.google.com/intl/en/privacypolicy.html.

March

11,

2009.

Department of Medieval Studies, Central European University. “Travel, Trade, and
Transportation: The Infrastructure of Spatial Mobility in Medieval East Central
Europe.” Accessed July 19, 2015. https://medievalstudies.ceu.edu/projects/traveltrade-and-transportation-infrastructure-spatial-mobility-medieval-east-central.

Books accessed electronically
Printed books accessed on Google Books or other online platforms need to be cited as a printed
book. The following guidance is only used for electronically published books.
Szilasi, László. “Mediocris Wathay avagy a szemérmes extractor: Funkcióváltás, hierarchiamódosítás és eszközcsere; A Balassi-imitáció változatai Wathay Ferenc költészetében”
[Medioris Wathay or the shy extractor: Changes of functions, hierarchy and means;
Variations of Balassi-imitations in the poetry of Ferenc Wathay]. Accessed June 6,
2007). http://szelence.com/tan/szilasi_wathay.html
Barth, Gunter. Bitter Strength: A History of the Chinese in the United States, 1850-1870.
Cambridge: Harvard University Press, 1964. NetLibrary e-book.
If the online edition of a printed book is important to be included, follow the format for
websites:
Philip B. Kurland and Ralph Lerner, ed. The Founders’ Constitution. Chicago: University of
Chicago
Press,
1987.
Accessed
June
27,
2006.
http://presspubs.uchicago.edu/founders/.
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Article in an online journal
Include a DOI (Digital Object Identifier) if the journal lists one. A DOI is a permanent ID
that, when appended to http://dx.doi.org/ in the address bar of an Internet browser, will lead
to the source. If no DOI is available, list a URL.
Kossinets, Gueorgi, and Duncan J. Watts. “Origins of Homophily in an Evolving Social
Network.” American Journal of Sociology 115 (2009): 405–50. Accessed February 28,
2010. doi:10.1086/599247.
If using a URL, it is advisable to use a Permanent URL (PURL), which is static and reliable.
Some databases call this a "Permalink."

Blog entry or comment
Bog entries and comments are commonly omitted from a bibliography, unless they cite
essential data not found elsewhere or are subjects of analysis. If necessary to include them,
follow the format below. Please note that similarly to publications with no known author or
editors, definite articles are transposed for ease of alphabetization.
Becker-Posner Blog, The. http://uchicagolaw.typepad.com/beckerposner/.

4.3.5 Reference books
Well-known reference books, such as common dictionaries and encyclopedias, are normally
cited in the footnotes (with edition specified and full publication facts omitted), but not
included in the bibliography.
Reference books that are not well-known should be cited in the bibliography, using full
citations.
Smith, Andrew F. The Oxford Encyclopedia of Food and Drink in America. 2 vols. New
York: Oxford University Press, 2004.

4.3.6 Non-Standard Sources
Some sources you may come across may defy the bibliographic formulas described above. In
the field of Medieval Studies especially, students and researchers often face various types of
primary sources or formats there is no clear guidance for. Some are collected in the sections
below, some will have to be invented as you go based on consultation with your supervisors
and the academic writing instructor. It is, as usual, the basic rule that such references need to
be consistent throughout the thesis and explanatory notes may be necessary to clarify certain
choices of format or citation.
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Facsimile Reprints
Facsimile reprints are exact copies of works, usually those published many years earlier. Even
though the facsimile can be expected to be accurate, it is important to inform the reader that
the facsimile exists and that you did not necessarily handle the old edition.
Theodore Balsamon. Opera quae reperiri potuerunt omnia. 2 vols. Paris: J-P Migne,
1865-. Facsimile reprint, Athens, Greece: Center for Patristic Publications,
1994.
Note that the author details, even the title of the work, on the title page of a facsimile reprint
might not correspond to the details in the original book: in this case, cite the details as they are
given on the facsimile reprint – the book that you are using.
Hunter Blair, Peter. Northumbria in the Days of Bede. London: Collins, 1976. Facsimile
reprint, Felinfach: Llanerch, 1996.

Early Printed Books
It may be difficult to give full or conventional citations for early printed books. Author details,
publication details, and the year of publication may all be missing or matters of speculation.
Nevertheless, the principles of citations for printed books should be applied as far as possible.
Boece, Hector. Scotorum Historiae a prima gestis origine. Paris, 1527.
Note that in the nineteenth century, and earlier, publishing clubs often performed the roles of
modern publishers: a club should be cited as the publisher:
Registrum Episcopatus Brechinensis. Edinburgh: Bannatyne Club, 1856.

Catalogues
Where the organizers or authors are known treat them as editors:
Fodor, István, László Révész, Mária Wolf, and Ibolya M. Nepper, ed. A honfoglaló
magyarság: Kiállitási katalógus [The ancient Hungarians: Exhibition
catalogue]. Budapest: Magyar Nemzeti Múzeum, 1996.
If the names of the organizers or authors do not appear in the catalogue, the title should be used
as the main entry in the citation. Note that a catalogue will usually be published by the gallery
or institution that hosts the exhibition or event.
Celebration: A World of Art and Ritual [Exhibition catalog]. Office of Folklife
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Programs and Renwick Gallery of the National Museum of American Art.
Washington, D.C.: Smithsonian Institution Press, 1982.

Annuals
Citation of an annual such as that of the Department of Medieval Studies follows the same
pattern as that of collected works (see above, p.6). However, note that although the year of
publication forms part of the title on the title page it should not appear in both the title and at
the end of the citation.
Sallay, Dóra. “The Eucharistic Man of Sorrows in Late Medieval Art.” In Annual of
Medieval Studies at CEU. Vol. 6. Ed. Katalin Szende and Marcell Sebők, 45-80.
Budapest: Central European University, Department of Medieval Studies, 2000.
Some publications that look like journals are in fact annuals. A series of annuals are produced
each year in Russia with a set arrangement of volumes numbered by topic. In this case they
will not have issue numbers as a regular journal does. In order to locate the reference, the
reader needs to know the year of publication, the volume, and page number as well as the basic
information of author, title, and so on.
Vinogradov, Victor V. [В. В. Виноградов]. “К изучению стиля протопопа Аввакума,
принципов его словоупотребления” [Concerning the studies of the style of
Archpriest Avvakum and the principles of his word usage]. Труды Отдела
Древнерусской Литературы, no. 14, 371-79. Moscow: Nauka, 1958.

Similar problems arise in Croatian sources, such as the publications of JAZU (Jugoslavenska
Akademija Znanosti i Umjetnosti) but citations can follow the formula set out for journals and
annuals:
Novak, Viktor. “Večenegin evandjelistar” [Večenega’s Evangeliary]. In Notae
paleographicae. Starine JAZU 51. Zagreb: Jugoslavenska Akademija Znanosti
i Umjetnosti, 1968.

Classical Works and the Bible
If it matters which edition you use give full citation in the footnote and the bibliography.
Otherwise you can omit citation altogether as both classical works and Bible verses are easy
to look up by section, and no separate bibliography entry is necessary. See footnote
formulation in the Classical works section above.

38

Miscellaneous


Make sure to delete hyperlinks to avoid blue underlined links in your bibliography.
To do so, right click on link and select Remove Hyperlink in the drop-down menu.



For information on citing government documents, reports, and legal cases, please see
The Chicago Manual 16th edition pp. 769-84 (sections 14.281-14.317), Turabian pp.
205-15 (sections 17.9-17.100).



For items retrieved from a commercial database, add the name of the database and an
accession number following the facts of publication. In this example, the dissertation
cited above is shown as it would be cited if it were retrieved from ProQuest’s
database for dissertations and theses.
Choi, Mihwa. “Contesting Imaginaires in Death Rituals during the Northern
Song Dynasty.” PhD diss., University of Chicago, 2008. ProQuest (AAT
3300426).



An example of a painting from an electronic source:
Friesach, Konrad, von. “Anbetung der Könige.” REALonline image no.
001810. Bildserver des IMAREAL. Institut für Realienkunde des
Mittelalters und der frühen Neuzeit. tethys.imareal.sbg.ac.at/realonline.
Last accessed December 3, 2006.



Maps:
name of archive or institution. archive or catalogue number. title of map, or name by
which it is known, in italics. name of cartographer, if known. date (n.d. if date not
known).
National Library of Scotland Map Library. MS 1648. Z3/1(a). Plan of Perth and
adjacent places. [cartographer unknown]. 1715-1716.



Aerial Photographs:
name of archive or institution. archive or catalogue number. grid reference or
description of area covered. date/approximate date of photograph (n.d. if date not
available or known).
Landesamt für Archäologie, Dresden. Arch. No.: 4746/050-1, 1291-38. Bauda,
Lkr. Riesa-Großenhain, Saxony, Germany. 03.07.94.
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APPENDIX 1: Excerpts from Penning the Past by Alyssa E.
Lodewick

Penning the Past: Advice on Writing in the Historical Disciplines
Alyssa E. Lodewick, Department of History, Brown University
Excerpts adapted for MA thesis writing by Judith Rasson. For the full article see:
http://www.ceu.hu/caw/resources
http://www.brown.edu/Student_Services/Writing_Center/resources_writers/article_lode
wick.html

Generally, history writing falls into two different categories-historical narratives, and
analytical essays. This dual-classification system is not quite as simple as it seems, though.
History professors seldom want their students to write analytical essays that don ’t include
any sort of historical narrative or contextualization. Occasions upon which professors
encourage their students to write purely narrative papers with no analysis involved are
even more rare; in fact, most professors are highly dissatisfied with papers that merely
“tell a story” but don’t in any way try to evaluate the story they have told. To avoid writing
narrative- or analysis-in-a-void, please take the time to read the following section entitled
“The Importance of Mixing Analysis and Narrative.”

HISTORICAL NARRATIVES
Much as the name implies, in narrative writing you narrate and analyze some particular
historical happening. Narrative writing usually takes the form of research in which you
undertake a detailed examination of a historical event/idea/person/era. In order to complete
this intellectual exercise, you will need to read a variety of primary and secondary sources
written about your particular topic. After selecting the most important/pertinent
information regarding your paper topic from these sources, you will tell the story of t he
topic you have researched. Finally, and most importantly, you will formulate some sort of
explanation for, or analysis of, the events you have described and include this
interpretation in your paper.
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ANALYTIC ESSAYS
In analytic writing you look at particular historical events, phenomena or sources and think
about/evaluate them in a critical manner. For example, using a variety of different primary
and secondary source materials on the topic, you might try to determine the most important
motivating factors behind President Woodrow Wilson’s decision to declare war on
Germany in 1917. Or perhaps you look at a particular historical document and try to place
it into historical context. For instance, you may read The Communist Manifesto and then
write on why Karl Marx and Friedrich Engels felt that 1848 was an ideal year to begin
circulating their revolutionary ideas. Finally, in historiographically-oriented analytic
essays you might critically evaluate a historical source document in isolation, by itself. 4
If, for example, you are studying the history of Asia, you might read the writings of Francis
Xavier, a Catholic missionary who travelled throughout India, Japan, and China between
1542 and 1552. You may evaluate the reliability and preciseness of Xavier’s depictions of
life in those countries, given his non-Asian cultural heritage. You might then have to argue
whether the source, with its inherent cultural biases, is of any use to historians hoping to
piece together accurate pictures of life in sixteenth century Asia.

THE IMPORTANCE OF MIXING ANALYSIS AND NARRATIVE
As a general rule, you should avoid writing all-analysis-with-no-narrative or, conversely,
all-narrative-with-no-analysis.
Provide your reader with a narrative context
Familiarize the reader with the sources and/or historic events that you plan to
analyze/critique/interpret.

For Whom Should One Write?: Assessing the Audience

“Historiography” has two different, but related, meanings. First, the term “historiograp hy” simply refers
to the body of written source materials-journal articles, books, etc.-on a given historical topic. Thus, the
term “historiography” can be used in the following manner: “Prior to the 1960s, the historiography of
immigration in the United States tended to stress ‘the melting pot theory’; most books written during the
era emphasized how different cultural groups tried to blend in with larger American society and become
‘Americanized’. During the 1960s, however, the intellectual landscape bega n to shift, and scholars focused
more upon the ways different immigrant groups managed to maintain their cultural differences in the works
that they produced.” Second, the term “historiography” simply means the critical study of written historical
sources and indicates an academic discipline of history in which all professional historians must engage.
4
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Anticipating the type of people in your audience is necessary because the act of doing so
helps you figure out how to structure your argument and your paper. A fair assumption is
that you are writing for an educated person who possesses a general knowledge of history.
However, you should not assume that the person reading your paper is an expert on your
topic. Thus, you cannot simply mention names, dates, events, etc. without also including
at least a brief description of their significance. (An exception to this rule might occur
when you mention a historical actor/date/event that is so famous and well known amongst
the general population that no description is necessary; anyone who has completed the
most elementary levels of schooling will recognize the person or event about whom/which
you write.)
As a responsible writer, you must make sure that your paper contains basic narrati ve
information about the context of different sources and events. For example, if you plan to
discuss a particular source document in your essay, introduce that source to the reader by
telling the reader who created it. Include information about when the source was
composed, and provide your reader with some knowledge about motivations for producing
the source: to which historic ideas or events did the author of the source respond?
Similarly, if you plan to examine a historic event in your paper, you must explicitly
identify your topic at the beginning of the paper, inform the reader as to when the event
took place, and name the actors who played roles in the event. In short, provide your reader
with background information on the subjects of your intellectual scrutiny before you
launch into the analysis of those subjects.
Providing your readers with a contextual framework for the sources/events you plan to
analyze serves several purposes. Most importantly, it shows your professors and outside
readers that you understand the historical circumstances in which source documents were
created and/or events took place. Comprehending the history behind events or sources
lends extra depth to your analysis of those events/sources, and highlighting your
knowledge about the historical context of your paper’s subjects lends credibility to your
interpretation of them. By providing the reader with background information, you prove
that you have gone beyond scrutinizing events/sources as isolated entities that exist
somewhere outside of time; you exhibit your own knowledge of how the examined source
documents/events fit into the overarching backdrop of history. Although including
historical context for analytical papers might seem tedious, providing it is well worth the
effort. In my experience, readers are more likely to accept an author’s arguments and
interpretations if they believe that the author has thought about his or her topic in a
complex, multi-faceted way.

Include analysis in everything you write

42

Including analysis in narrative papers is even more important than including narrative in
your analytic writings. If you turn in an analysis-free narrative or research paper, you will
fare poorly.
As historians, our job is not to merely tell the story of some past event or person, (although
telling stories is definitely one facet of our profession); after all, any child in primary
school can tell a simple story or write an account of some long-ago happening. Ask the
child to interpret the story that s/he has just told, however, and the child might well find it
difficult. The challenge of interpretation also sometimes proves trying for adults.
Nevertheless, it is our duty as historians and scholars to take up that gauntlet. We must not
only describe past events; we must try to make sense of them. We must not only chronicle
people’s actions; we must try to discover the causes behind them. Sometimes we fail at
our task. We come to events that we cannot explain, and we encounter actions whose
motivating factors we cannot penetrate. Yet simply by grappling with questions of
interpretation, we deepen the way we look at history, and add another layer of complexity
to our own thought processes-whether or not we succeed in making total sense of the past
in the end.
Don’t be afraid to analyze the stories that you tell in your research papers. As you write
and/or research, frequently ask yourself the two most important analytic questions: why
and how. Why did the subject you are writing about happen when it did? Why did events
unfold and take shape in the way that they did? How did environmental factors and
contemporary events interact with each other to help bring about the historical event you
are dissecting? In your search for answers, you might come up with an explanation for
events with which your professor and/or outside reader doesn’t agree. But try not to let
thoughts of being “wrong” frighten you too much, or you might become intellectually
paralyzed. Most professors care very little for whether or not you arrive at some
predetermined, “correct” historical interpretation. In fact, over the course of the twentieth
century, most scholars have forsaken the notion that there even exists one “correct,”
objective version of historical “truth” that students can comprehend through diligent st udy.
Thus, while most modern professors care greatly about whether or not their students
possess enough intellectual fortitude to tackle the task of analyzing history, they do not
expect their students to successfully come up with universally “correct” ans wers to
whatever analytical questions have been raised.
Even when they end up disagreeing with students’ interpretations of historical events or
sources, most professors recognize and appreciate the efforts of writers who: a.) research
their paper topics thoroughly, b.) successfully take up the challenge to think about their
topics in complex, multi-faceted ways, and, c.) describe their narratives and analyses
clearly, concisely, and completely. So analyze without fear. And most importantly, don ’t
turn in a thesis that simply states one fact after another and completely lacks your own
interpretation of those facts. Such writings are boring, and writers hoping to keep their
readers’ attention and interest should avoid being tedious.
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Make sure that you comprehend the language used to discuss your topic
First, you need to make sure that you understand your topic. For instance, pretend that you
are taking a course in American history, and that your professor has handed out a paper
with the following topic for an analytical essay:
Some scholars claim that the American Civil War was caused by a desire
among Northern millenialists to eradicate the “sinful evil” of slavery so that
Armageddon could occur. Other intellectuals believe that the War Between
the States was caused not by slavery, but by tension over states’ sovereignty
and the right to self-governance. Evaluate these explanations for the Civil
War, exploring the strengths and the weaknesses of each. In your mind,
which one provides a more believable explanation for the clash? Since
neither provides a complete account of why the conflict began, offer your
own explanation of the causes behind the struggle.
As is probably obvious, this “question” is made up of several different parts, and each
subsection calls upon you to do some critical thinking. Even before you break the question
down into its constituent parts, make sure that you know the meaning of key phrases in
the question. Start off by evaluating the essay topic on a sentence-by-sentence basis. Does
it contain specialized terms that you don’t fully understand, even though people may have
heard the terms used repeatedly? Are there words whose definitions are fuzzy in your
mind? If so, ask your professor or a classmate for some guidance. For the above essay
topic, you would certainly need to understand the term “millenialists.” You would also
need to comprehend the complexities behind the phrase “states’ sovereignty and the right
to self-governance.” There is just no way that you can sufficiently answer the question if
you lack knowledge of those fundamental concepts.

Make sure that you understand all of the question’s demands
After looking at the question’s terminology and language on the sentence level, evaluate
its different components or subsections. What is the question truly asking of you? Is it
made up of several parts or statements? If so, break the question down and make sure that
you understand each subsection in isolation. In the Civil War example given above, you
are dealing with two different foundation ideas: (1) the idea that the Civil War was caused
by millenialist concerns over slavery, and (2) the idea that the War Between the States was
caused by tension over states’ sovereignty and right to self-rule. In your essay, you need
to do three things:




examine each foundation idea in isolation and address its strengths and weaknesses
juxtapose the foundation ideas and, after looking at them in relation to each other,
explain which one has more merit
include your own interpretation of the motivations behind the Civil War
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If you fail to address any one of these three requirements, you have not successfully
explored the essay topic, regardless of how fully and completely you responded to the
other two requirements. Only after coming to terms with the essay question or topic and
what it demands of you should you try and figure out how you want to actually answer the
question or address the topic.
Working with Sources
Once you have decided upon a topic that interests you and can be successfully researched
given the resources available to you and you have identified all of the issues that essay
requires you to address, you undertake a complete examination of the source materials you
plan to utilize or discuss in your paper.
THOROUGHLY EXAMINE ALL OF YOUR PRIMARY AND SECONDARY
SOURCES
In both narrative and analytic writing, the next step you take is the same: Usually the list
of source materials will include both primary sources and secondary sources, so it is
important to understand the difference between the two.

Definitions: Different Types of Historical Sources 5
Primary sources are the materials that you are directly writing about, the “raw materials”
of your research. In fields that study writers or documents, the texts you write about are
primary sources. In fields such as English or history, you usually cannot write a research
paper without using primary sources. [In the discipline of history, the primary sources that
you will use might, depending upon your topic, include: personal journals/diaries; letters;
newspapers and magazines published around the time of whatever particular event -or
during whatever general chronological era-you are scrutinizing; novels; the personal
and/or professional writings of historical figures; films and movies; pieces of music;
pieces of art; folk stories; oral histories, etc.]
Secondary Sources are books and articles in which other researchers report the results of
their research based upon primary data or sources. [In the province of history, these are
usually books that scholars have written to disseminate any findings gleaned during their
own historical investigations. In the context of your own research, think of “secondary
sources” as the body of books/articles that other researchers have already written about
your particular research topic.] You quote or cite them to support your own research. If a
researcher quoted your paper to support his argument, your paper would be his secondary

5

Except where text is located in brackets [ ], Lodewick took these definitions directly from Wayne C.
Booth, Gregory G. Colomb, and Joseph M. Williams, The Craft of Research (Chicago: University of
Chicago Press, 1995), 69.
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source. If, on the other hand, he were writing your biography, your paper would be a
primary source.
Tertiary Sources are books and articles based on secondary sources, on the research of
others. Tertiary sources synthesize and explain research in a field for a popular audience
or simply restate what others have said. Tertiary sources can be helpful in the early stages
of your research, but they make weak support for your argument because they often
oversimplify and overgeneralize, are seldom up to date, and are usually distrusted by
experts. [In history, tertiary texts often take the form of review or synthetic essays that
discuss a number of different secondary sources in relation to one another. In general, I
advise against utilizing tertiary sources as evidence in your own research projects, for all
the reasons given above.]
Studying a variety of primary and secondary source materials will enable you to fulfill
several goals. They will help you:








understand the basic facts about the topic you are covering
use those facts to build a chronological framework for your topic
place the topic of your paper into broader historical context
review what other scholars have written about your topic
look at your topic from a wide range of vantage points (assuming that your sources
were not all written by the same author)
build your own argument/thesis
support assertions that you make in your argument/thesis with historical evidence
and examples taken from your sources

GUARD AGAINST MISUSING AND MISINTERPRETING SOURCES
As is obvious, source materials are crucial to any historical investigation. Because source
materials are the building blocks for history essays and papers, and because you will use
them to bolster the arguments you put forth in your writing, you must take great care when
using different sources. If you misuse a source-for example, by purposely using a quote
out of context in order to make it “fit” with your own argument (a calculated misuse and
an intellectual misdemeanor), or by attributing intentions to a source’s author that the
author never possessed (a misuse often stemming from misunderstanding or a lack of
knowledge)-you risk damaging your own argument’s credibility. It matters not whether
you misuse a source intentionally or accidentally; in either case, the misuse is usually
detectable, especially to professors, who have read large amounts of good (not to mention
bad!) history in their careers.
So how can you guard against such mistakes? In short, examine each source carefully so
that you do not misinterpret what the source is saying. Recognize the limitations of each
source that you use. Take care to complete these tasks with a questioning attitude and a
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critical eye. In your mind, ask all sorts of questions about each of your sources, such as:
Why was each source produced when it was? (This is especially important to ask when
dealing with primary sources.) Who created each source, and for what reason? How does
the source inadvertently (or, in some cases, purposefully) show the biases of its author?
How accurate is the story each source tells, and how completely can a modern reader trust
the claims that are put forth in it? Put baldly, each source with which you deal -whether
primary or secondary-was written by an author who possessed/possesses biases,
prejudices, and personal agendas. You need to be aware of these factors or you cannot
fully understand each source in all of its complexity.
Modern historians usually find the task of ascertaining the true subconscious motivations
and ideologies that influenced the formulation, revision, and publication of written source
documents nearly impossible. In many cases, all of the people intimately involved in
producing and issuing a certain source are long dead. Obviously, we cannot ask their
ghosts to explicate the rational and logic that lay behind decisions in the writing and
editing processes. Even if we could communicate with dead authors and editors, we could
not trust them to relate or acknowledge their true motives; we would still be unable to “get
inside their heads” and analyze the effects of subconscious or masked personal and social
goals upon the narrative’s veracity.
Thus, as historians, we come upon moments of despair. Can we really trust any source? If
we cannot be sure that the authors of our sources did not modify the events/thoughts that
they depicted in order to further personal goals, can we really believe anything that the
authors wrote? I would argue yes, under certain conditions that we ourselves create.

USE A WIDE VARIETY OF SOURCES IN CORRELATION WITH EACH OTHER
First, no matter what sort of history we write, we must be sure to use a broad variety of
sources, both primary and secondary. Including many sorts of historical sources in our
research helps us contextualize not only the historical events we choose to analyze, but
also the sources themselves. Just as importantly, we must use source documents in
correlation with one another. We must take one source and verify its contents through
thorough research in other sources. Only when we analyze a specific historical document
in relation to a plurality of various other sources can we better discern the “truths”
contained in our original source. As long as we do not accept our sources at face value,
and instead use them in conjunction with data gathered from a myriad of sources, source
documents written long ago by people whose heads we cannot enter can prove meaningful,
valid, and useful.

USE SOURCES AS SPRINGBOARDS FOR YOUR OWN ANALYSIS
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Now that I have established the necessity of using a wide variety of sources in conjunction
with each other, I want to say a few concrete words about how to actually use those
sources. At this point, you know that you will utilize primary and secondary documents
for a variety of reasons while writing your paper. In some cases-especially in
historiographically-oriented analytical essays-you might discuss a certain source
document in order to raise questions or criticisms about a.) the source itself, or b.) i deas
contained within it. You would then proceed to address these questions and issues in your
paper. For example, if you were responding to an essay topic about the origins of the
Progressive movement in America, you might write the following sentences:
In The Search for Order, historian Robert Wiebe argued that due to the
industrialization, urbanization, immigration, and economic depression that
occurred at the end of the nineteenth century, “Americans in a basic sense
no longer knew who or where they were.” 6 He claimed that the Progressive
movement arose in reaction to this sense of disorientation and that it was
characterized by middle-class efforts to re-construct a stable, well-ordered
society. However, several problems arise in Weibe’s assertions that scholars
need to address. . . . [Getting back to your own analysis, you would then go
on to list and discuss some of those problems.]
I call the above technique of using a source the “springboard” method because when you
use it, you touch upon a point raised by a source and then use that point as a springboard,
or jumping-off point, to launch into your own analysis or critical evaluation.

USE SOURCES AS SUPPORT OR EVIDENCE FOR YOUR OWN ARGUMENT
You can manage source documents so that they operate as a springboard quite effectively.
However, I imagine that the most crucial and frequent role that historical source
documents will play in your writing is that of support or evidence for your own assertions
or arguments. Note that the key word here is “support.” The sources should not dominate
the paper, but should instead serve as supportive voices that merely back up what you
yourself have said. Do not simply string together a bunch of quotations from other authors
and expect those authors to speak for you. Your own ideas and your style of writing should
be dominant in the paper, because you want the reader of the paper to walk away with your
voice-and not that of some other author-echoing in his/her head.

USE DIRECT QUOTES, BUT ENSURE THAT YOUR OWN IDEAS AND VOICE
DOMINATE THE PAPER

6

Robert H. Wiebe, The Search for Order, 1877-1920 (New York: Hill and Wang, 1994), 42.

48

In order to avoid granting too much power and devoting too much space to other authors,
use direct quotes from your sources sparingly. When discussing ideas or information found
in written sources, try to paraphrase whenever possible. You might use a direct quote if:



it is important to show the reader the source’s exact language or wording in order
to make your own analytical point
there is no way that your own wording can capture an idea as succinctly, efficiently,
memorably, or perfectly as the source document did

In general, try to keep the quotes as short as possible. Only quote the sentences and/or
phrases in the source document that are immediately relevant to the idea at hand. If you
have many sources that say the same thing, only quote the one that says it best; in an
informational footnote at the bottom of the page, you can always add something like the
following:
[The last name of the author you’ve quoted] is not the only scholar who has discussed
[whatever topic is at hand]. [Dr. So-and-so] and [Scholar X] have also advanced similar
ideas in their works, [Dr. So-and-so’s Book Title] and [Scholar X’s Book Title].
Of course, you can entirely avoid the trouble of adding an informational footnote by
including a brief mention of the other authors who have covered the same ground
somewhere in the paragraph itself; a logical place would be directly before or after the
quote itself.
Unlike you, your reader hasn’t seen the source in its entirety. S/he also isn’t omniscient,
and is not inside your head; therefore, the logical connection between a particular quote
and your argument is not automatically clear to the reader, no matter how clear and rational
the link seems to you. In short, when working with quotes, you must ensure that a reader
understands the purpose of each quote that you include in your paper. You need to
elucidate how each quote is relevant to your topic, and you need to clarify why/how you
are utilizing each quote.

AVOID PLAGIARISM BY CITING YOUR REFERENCES TO OTHER SOURCES
If you are only going to remember one thing about writing history, remember this: give
credit to other authors when it is due. Plagiarism, or the act of using the ideas or words of
another person without granting that person recognition, is not only dishonest-because you
are, in essence, claiming those words or ideas as your own-it is also an intellectual crime
that has been prosecuted in courts of law. So just to be on the safe side, cite, cite, cite.
Figuring out how to cite sources should not take too long, and the practice will soon
become second nature.
Student writers with whom I work frequently voice the complaint that determining what
constitutes plagiarism can be confusing. Most people find it fairly obvious that copying
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another author’s words into one’s own work without crediting that other author constitutes
plagiarism. In addition, you “plagiarize even when you do credit the author but use his
exact words without so indicating with quotation marks or block quotations. You also
plagiarize when you use words so close to those in your source, that if you placed your
work next to the source, you would see that you could not have written what you did
without the source at your elbow.” 7 Finally, the act of taking another person’s idea, putting
it into one’s own words, and then including it in one’s paper-without acknowledging that
the idea came from some other source-is plagiarizing.
Some students try to avoid plagiarizing by shunning the use of direct quotes. Instead of
copying another author’s words exactly, the students attempt to paraphrase-or put into
their own words-passages from primary and secondary texts. This is not a bad idea, but in
order for paraphrasing to work, two things must be remembered.
The act of paraphrasing does not give you permission to copy almost an entire passage,
simply changing a few words here or there. If you are only changing an occasional word
or phrase, or if you are keeping most of the important phrases from the original text in
your own version, you are not paraphrasing, and you would be better off directly quoting
the source. As Wayne Booth, Gregory Colomb, and Joseph Williams remind us in The
Craft of Research, “close paraphrase may count as plagiarism, even if you cite the
source.” 8
Even when you do paraphrase correctly, and completely re-word the statement of an idea
so that it reflects your own phrasing and not that of the original author, you need to cite
the material that you have paraphrased because it contains ideas that originated in the mind
of somebody else. You might not be directly quoting another author, but you are still
discussing another scholar’s thoughts.
A Quick Test to Help Avoid Plagiarism 9
Be conscious of where your eyes are as you put words on paper or on a
screen. If your eyes are on your source at the same moment your fingers are
flying across the keyboard, you risk doing something that weeks, even
months, even years later could result in your public humiliation. Whenever
you use a source extensively, compare your page with the original. If you
think someone could run her finger along your sentences and find synonyms
or synonymous phrases for words in the original in roughly the same order,
try again. You are least likely to plagiarize inadvertently if, as you write,
you keep your eyes not on your source but on the screen or on your own
page, and you report what your source has to say after those words have
been filtered through your own understanding of them.

7
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9
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Due to the serious nature of plagiarism, you may well wonder whether there are ever
instances in which you can incorporate ideas or language that did not originate in your
own mind into your writing without including citations. I will respond by saying that there
is never justification for not citing-and enclosing in quotation marks-specific language
lifted directly from other documents. Technically, scholars are often excused from citing
“commonly-known” ideas or facts; however, the question of what constitutes “commonlyknown” is very murky. To be on the safe side, I encourage you to go ahead and use a
citation if you have any doubts about whether an idea/fact you want to discuss is
“commonly-known.” In my mind, it is better to cite too often, and err on the side of being
overly cautious, than to cite too infrequently and risk being brought up on charges of
plagiarism. I also strongly advise you to talk to your professor or an academic writing
instructor if you have specific questions about whether or not something needs to be cited.

Creating an Argument and Using it to Organize Your Paragraphs
We have finally reached the “writing” stage of constructing a history paper. You have
formulated a topic. Through research in a variety of primary and secondary sources, you
have developed a general sense of where you anticipate your paper will go. In the back of
your mind, you have a feel for the points that you want to cover. The next step is to come
up with an argument, or thesis, that sums up the paper’s main ideas and tells the reader
what you will attempt to prove in the paper.

WRITE IN PAST TENSE, NOT PRESENT TENSE
Before I launch into a discussion of creating an argument, I should remind you to use the
past tense when you write history papers. As Mary Lynn Rampola explains in A Pocket
Guide to Writing in History,10
The events that historians write about took place in the past; therefore,
historians conventionally use the past tense . . . The use of the present may
be a very effective device [in other fields], but it is awkward in a history
paper. First, readers might become confused about whether the events under
discussion happened in the past or present, especially if the paper includes
modern assessments of the issue. Second, the use of the present makes it
very easy for the writer to fall prey to anachronism. Perhaps more important,
writing in the present sounds artificial; in normal conversation, we talk
about events that happened in the past in the past tense. The same approach
is also best for writing.

10

(Boston:Bedford/St, Martin's, 1998), 38.
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Regardless, there are important times in history when you should use the present tense.
For example, when you discuss the contents of a source document itself, use the present
tense, since that source document is still “alive” and speaking to you as a modern reader.
Thus, even though you should use the past tense when writing “the framers of the
American Constitution intended to balance individual liberties with community
responsibility,” you should use the present tense when claiming that “the Constitution
guarantees certain individual rights.” In the first phrase, you use the past tense because the
framers of the Constitution completed the action of “intending” long ago. You use the
present tense in the second phrase because the Constitution is still in existence and acting
to “guarantee” individual rights even as you pen your history paper. Now, with the
question of which tense to use out of the way, let’s move on to a discussion of how to
formulate an argument.

AN ARGUMENT IS NOT A STATEMENT OF FACT, BUT A DEBATABLE
STATEMENT THAT YOU MUST PROVE
Much as the term “argument” implies, you cannot simply state an incontestable fact and
use it as your argument. For example, the sentence “When Europeans arrived in the ‘New
World,’ they brought with them diseases that decimated entire groups of Native
Americans” would not serve as an acceptable argument because it is undeniably true. You
could, however, use this statement as an argument if you amended it slightly and declared
that “When Europeans arrived in the ‘New World,’ they brought with them diseases that
proved to be the main factors in the downfall of Native American civilizations.” Unlike
the first statement, which really didn’t assert anything questionable but merely stated a
fact, this second statement makes a claim that is open to debate; scholars other than
yourself might argue that drought, rather than disease, was the main killer of Native
Americans throughout the 1500s. Similarly, you could not use as your argument a
statement like “In The Decameron, Giovanni Boccacio described life in the city of
Florence during the 1300s, when the plague swept through Europe.” Once again, this is a
statement of fact and contains no assertions that need to be defended or proved. If you
transformed the statement into “Boccaccio’s treatments of love and the Black Death in
The Decameron prove that his interpretation of Florentine society was subjective and thus
is historically questionable,” you would have a usable argument around which to frame
your paper.
When attempting to determine whether your thesis statement is really an argument (which
it should be!), ask yourself whether someone could contest what you are claiming. If so,
then you have formulated a genuine argument. Once you have stated that argument at the
paper’s beginning, you will spend the rest of the paper: a.) supporting your argument and,
b.) rebutting possible attacks against your argument. Play devil’s advocate. Imagine that
you are your own worst enemy-someone who is trying to disprove the argument that you
have put forth. What flaws in your argument will your opponents point out? Where are the
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lapses in your thesis? Once you have determined the weaknesses in your own argumen t,
you can work on eradicating them.

PLACE YOUR ARGUMENT EARLY IN THE PAPER, AND MAKE IT AS
SUCCINCT AS POSSIBLE
Present your thesis to the reader as early in the paper as possible. The less time the reader
has to spend wondering where the paper will take him or her, the better.
Flexibility is important when planning a thesis; keep the advice of a secondary school
teacher in mind when you start to construct your argument. Pretend that you have to place
the argument at the end of your first paragraph, and pretend that it is limited to only one
sentence. This is a good idea for two main reasons. First, believing that an argument should
only be one sentence long encourages you to think long and hard about what you really
want to get across in your paper. In the course of paring down all of your ideas so that they
fit into a single research-question sentence, you will eradicate unneeded, obstructive
thoughts that are floating around in the back of your mind; organizing the paper will
become much easier. Second, trying to construct a paper in which the argument appears at
the very end of the first paragraph will help you create a well-thought-out framework upon
which to “hang” the rest of the paper.

MAKE THE THESIS MANAGEABLE; DON’T TRY TO TACKLE TOO MANY
IDEAS
Since the argument is one of the most important elements of your thesis, you need to spend
some time developing it. One of the most valuable pieces of advice I can give you is this:
don’t try to tackle too many ideas! You will only end up frustrated. Simple identification
of your argument can be a troublesome task if you have a myriad of thoughts in your head
and are unsure as to which ones should be stressed in the paper. To gain some clarity, try
the following exercise. Keeping in mind all of the ideas that you want the thesis to cover,
pretend that when your reader walks away from your paper, most of the writing will fade
from her mind. She will, however, remember one major point. What do you want this point
to be? This point-the one that you want your reader to recall, even if she forgets everything
else she has read-is your argument or thesis.
What if you have two or three major ideas that you want your reader to remember? First,
I would encourage you to examine those ideas to see if you can place them in some sort
of hierarchical order. Is one idea slightly more important than the others are? Does one of
the ideas serve as a bridge or connector between the others? If not, can you think of a
“higher,” overarching idea that links all of the ideas? If you can answer any of these
questions affirmatively, you have identified your main idea, and it should be the focus of
your thesis statement. The other ideas in your mind are important, but they are ideas that
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merely support, advance, or are connected to the main idea; they do not need to be the
focus of your argument.
You will indubitably run into situations where you have two or three main ideas and all of
them are equally important. This means that your thesis is comprised of several sub components; due to this complexity, statement of the research problem might necessarily
take more than one sentence. A brief examination of Christine Stansell ’s City of Women:
Sex and Class in New York 1789-186011 highlights a two-pronged thesis. On page xiv,
Stansell ends the “Introduction” to her work by concluding that in the late 1700s and early
1800s, New York City was
a place set off from the rest of the country in many ways. In its
cosmopolitanism, its extremes of wealth and poverty, its breadth of human
enterprise, it resembled London and Paris . . . But if unique, New York was
far from irrelevant to the rest of America: It was a historical stage writ large
for encounters that reverberated across the rest of the nation. It was the home
of a radical working class and the site of intense class conflicts before the
Civil War; it was also at the forefront of middle-class commercial and
domestic culture. . . . Already by the 1840s an arbiter of gender fashions and
expectations, New York was a testing ground for much that was new
between the sexes. For poor women in this city, a new configuration of
suffering and possibility was just beginning to move into place.

Through this paragraph, a reader senses that Stansell will touch upon many topics in her
book, including New York’s “cosmopolitan” nature, its class struggles, and its
“commercial and domestic culture.” The reader can also tell, however, that these sub topics are not Stansell’s main concern, and so her argument does not revolve around them.
Instead, Stansell’s argument focuses upon the following two points: 1.) by the 1840s, New
York was a “testing ground” for changing conceptions of gender and gender relations, and,
2.) New York’s shifting gender landscape brought with it new options for poor women in
the city, along with new suffering.

In Stansell’s work, we see a situation where an author obviously has many ideas and topics
that she wants to discuss in her work. Fortunately for the reader, she has skillfully
distinguished the major points that she actually wants to prove and placed them in two
sentences that, when combined, make up her argument. As mentioned earlier, implicit in
the word “argument” is the idea that a writer is taking a stand that other scholars can argue
against. In Stansell’s mind, there is no question about whether New York was sophisticated
or a place of socioeconomic turmoil. Thus, the topics of New York’s sophistication and
its social, economic, and cultural complexity do not serve as a debatable foundation for an
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argument; instead, Stansell uses a discussion of those topics as background and context
for an exploration of her thesis.

DO A THOROUGH JOB ANALYZING AND EXPLAINING EACH IDEA
CONTAINED IN THE THESIS
Once you have formulated a strong argument, you can work on developing the rest of your
thesis. The shape of your paper will depend in large part upon your particular argument.
Does your argument call upon you to compare and contrast two different historical
sources? Does it demand that you explain the causes of a certain historical phenomenon?
Have you promised to explore the effects of an historical happening? Different types of
arguments require papers that are structured differently.
Despite the large number of possible paper structures, I can confidently render the
following piece of advice: discuss each idea in your paper fully and completely. In the
course of determining your essay’s argument, you should have spent some time paring
down the number of ideas that you plan to address in the paper. Limit yourself to exploring
those ideas and sub-topics that can be analyzed in a complex, multi-faceted manner given
the assignment’s page and time constraints. You are better off writing about fewer ideas
in great detail and with increased insight and depth than presenting the reader with a broad
collection of undeveloped, unconnected thoughts.

BE SURE THAT EACH PARAGRAPH IS CONNECTED TO YOUR ARGUMENT
Throughout the writing process, you should remain conscious of how each paragraph
connects with your argument. Paragraphs can play a variety of functions. They can:






present new evidence to support your argument
provide the reader with the background or context necessary to fully understand
your argument
anticipate and address counter-arguments that might be launched at your argument
elucidate or define how you are using a particular term in your argument
explore the relationship between different parts of your argument, if your thesis is
composed of various sub-ideas

There are few things more distracting to a reader than unnecessary paragraphs that d on’t
seem to serve any purpose in the paper. Such paragraphs disrupt the flow of the essay and
shatter the reader’s concentration.
So how do you avoid including useless paragraphs of clutter? At the end of each paragraph
composed, ask yourself how the paragraph clarifies or furthers your argument; if you have
a difficult time figuring out a paragraph’s purpose, your reader will as well. You also must
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ascertain that you have made perfectly explicit the paragraph’s relation to your argument.
Of course, since you have written the paper, you know why you have included each
particular paragraph; the whole paper seems quite logical to you. But will your rationale
for including different paragraphs also be evident to a reader who hasn’t been inside of
your head throughout the writing process? Finally, when you finish the first draft of your
paper, re-read your work. As you work through each paragraph, ask yourself what would
happen if you took the paragraph out of the paper. Would your argument still be as clear
and strong? If you can remove a paragraph without in any way harming your ability to
prove your thesis, that paragraph might not be necessary. You may be able to remove it
and fill its space with significant material that is more relevant to your argument, and thus
more important to your paper.

Conclusion
The process of writing a thesis can be daunting if you are a relative newcomer to graduate
study. However, you must realize that at its core, the goal of writing history is not much
different than the goal writing in any other scholarly realm; in every instance where you
put pen to paper, you try to convince your reader that your words and ideas merit attention
and serious consideration. Above all else, remember that writing is not an easy task for
anyone and that even the “experts” continually revise their pieces in order to craft better finished products. Only through continued, persistent practice can we improve our writing
skills; if you keep plugging away at the art of penning history, you will become a far better
writer than you ever thought you could be.
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